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About This Guide

This guide describes how to set up and operate the BD™ High Throughput 
Sampler (HTS) option with the BD™ LSR II, BD LSRFortessa™, 
BD FACSCanto™, and BD FACSCanto™ II flow cytometers. You should know 
how to operate your flow cytometer before using the HTS. For important safety 
information, see the safety guide provided with the HTS.

Cytometer function is controlled by BD FACSDiva™ software. In this guide, you 
will find a description of BD FACSDiva software features specific to the HTS.

BD LSR II, BD LSRFortessa, BD FACSCanto, and BD FACSCanto II flow 
cytometers modified with the HTS can acquire samples from plates or tubes. 
Even when acquiring samples using the HTS, consult the appropriate cytometer 
user’s guide for information about flow cytometer operation, daily shutdown, 
maintenance, and troubleshooting. 

The BD High Throughput Sampler User’s Guide assumes you have a working 
knowledge of basic Microsoft® Windows® operation. If you are not familiar 
with the Windows operating system, see the documentation provided with your 
computer.
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Conventions

The following tables list the conventions used throughout this guide. Table 1 lists 
the symbols that are used in this guide or on safety labels to alert you to a 
potential hazard. Text and keyboard conventions are shown in Table 2.  

Table 1  Hazard symbolsa

a. Although these symbols appear in color on the cytometer, they are in black and white throughout this user’s 
guide and their meaning remains unchanged.

Symbol Meaning

Caution: hazard or unsafe practice that could result in material damage, data 
loss, minor or severe injury, or death

Risk of electric shock

Biological risk

Table 2  Text and keyboard conventions

Convention Use

NOTE Describes important features or instructions.

Italics Italics are used to highlight book titles and new or unfamiliar terms 
on their first appearance in the text. 

> The arrow indicates a menu choice. For example, “select File > 
Print” means to select Print from the File menu.

Ctrl+X When used with key names, a plus symbol means to press two keys 
simultaneously. For example, Ctrl+P means to hold down the 
Control key while pressing the letter p. 
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Technical Assistance

For technical questions or assistance in solving a problem:

• Read the section of the user’s guide specific to the operation you are 
performing. 

• See Chapter 5, Troubleshooting.

If additional assistance is required, contact your local BD Biosciences technical 
support representative or supplier. 

When contacting BD Biosciences, have the following information available:

• Product name and serial number

• Any error messages

• Details of recent system performance

For cytometer support from within the US and Canada, call 877.232.8995.

Customers outside the US and Canada, contact your local BD representative or 
distributor.

If you need to send your HTS back to BD Biosciences for repair, see Appendix B 
on page 165 for instructions. Note that depot repair procedures might be 
different outside of the United States. Contact your local BD Biosciences service 
representative for information for your region.
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New Functions for the HTS

BD FACSDiva software version 7.0 includes the following new functions that 
work specifically with the HTS:

• Automation. This function allows you to connect to BD FACSDiva 
software via a server socket to issue commands such as creating 
experiments and recording plates through the use of a published command 
Application Programming Interface (API). You can set up a walkaway type 
of automation process where clients can coordinate interactions between 
external hardware (such as robotics), third party software, BD FACSDiva 
software, and the cytometer.

• Baseline restore. This function is available for the BD FACSCanto, 
BD LSR II, and BD LSRFortessa cytometers. At the start of data acquisition 
and only when data is recorded, BD FACSDiva software ignores the initial 
data for a period of time defined by the baseline restore period. 
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1

System Overview

The HTS is a compact, high-speed sample loading device for use with the 
BD LSR II, BD LSRFortessa, BD FACSCanto, and BD FACSCanto II flow 
cytometers. BD FACSDiva software controls the sample loader, providing 
automated acquisition of samples from a multiwell plate.

The following topics are covered in this chapter:

• Hardware Overview on page 14

• Components on page 17

• Cytometer Connections on page 21

• Setting Up for Plate-Based Acquisition on page 28

• Acquisition Sampler Modes on page 34
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Hardware Overview

The HTS provides the following basic functionality:

• Acquires samples from 96- and 384-well plates (standard depth)

• Includes two throughput modes: standard and high

• Minimizes carryover

• Provides user-definable mixing and sample introduction protocols

• Is user-installable (software and HTS only, initial installation excluded)

• Supports immunophenotyping assays

The HTS can process a 96-well plate in approximately 44 minutes in standard 
mode and approximately 15 minutes in high-throughput mode using the default 
settings listed in Table 1-1.

Table 1-1  Default throughput mode settings

For more information, see Loader Settings on page 51.

Setting Standard Mode High-Throughput Mode

Sample flow rate (µL/sec) 1 1

Sample volume (µL) 10 2

Mixing volume (µL) 100 50

Mixing speed (µL/sec) 180 200

Number of mixes (cycles) 2 2

Wash volume (µL) 400 200

Approximate acquisition time (min) 44 15
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The HTS is installed on the cytometer by a BD Biosciences service engineer. Once 
installed, the HTS enables quick conversion of the flow cytometer from tube to 
plate-based acquisition.

Figure 1-1  HTS on a BD LSR II flow cytometer

Figure 1-2  HTS on a BD LSRFortessa flow cytometer (front orientation)
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Figure 1-3  HTS on a BD LSRFortessa flow cytometer (side orientation)

Figure 1-4  HTS on a BD FACSCanto II flow cytometer
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Components

The following figures show the hardware components of the HTS.

Figure 1-5  HTS for BD LSR II, BD LSRFortessa, and BD FACSCanto cytometers (front view)

Component Description

Plate holder Moves left to right and front to back to position the plate so the 
probe can pick up sample.

Primary pump 
and valve

Enables mixing and aspiration of sample and delivers it to the flow 
cell in standard mode.

Power switch Turns the HTS on and off. Has an LED indicator.

Power switch

Plate holder

Primary pump and valve
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Figure 1-6  HTS for BD LSR II, BD LSRFortessa, and BD FACSCanto cytometers (rear view)

Component Description

Sheath filter Filters incoming sheath fluid to the HTS.

Fluidics tubing Carries sheath (clear) and waste (orange).

Probe assembly Moves front to back and up and down to transfer sample between 
the plate holder and the injection port/wash station.

Injection port/
wash station

Provides an interface for sample injection and probe washing.

Injection port 
and wash 
station

Secondary 
pump and 
valve

Sample 
coupler

Absorbent 
pad

Fluidics tubing

Probe 
assembly

Sheath
filter
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Figure 1-7  HTS for BD FACSCanto II (rear view)

Secondary 
pump and valve

Delivers sample to the flow cell in high-throughput mode.

Absorbent pad Collects potential overflow from the injection port/wash station or 
drips from the cytometer sample injection tube (SIT).

Sample coupler Connector between the HTS and the cytometer SIT.

Component Description

Sample coupler
Probe assembly

Fluidics tubing

Sheath filter

Door sensor cable
connector

Injection port and 
wash station

Plate holder

Secondary pump 
and valve

Overflow reservoir
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Component Description

Probe assembly Moves front to back and up and down to transfer sample 
between the plate holder and the injection port/wash station.

Sheath filter Filters incoming sheath fluid to the HTS.

Door sensor cable 
connector

Detects if the safety door is open.

Fluidics tubing Carries sheath (clear) and waste (orange).

Sample coupler Connector between the HTS and the cytometer SIT.

Plate holder Moves left to right and front to back to position plate so the 
probe can pick up sample.

Injection port/
wash station

Provides an interface for sample injection and probe washing.

Secondary pump 
and valve

Delivers sample to the flow cell in high-throughput mode.

Overflow reservoir Collects potential overflow from the injection port/wash station 
or drips from the cytometer SIT.
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Cytometer Connections

Cytometer Interface Panel

The HTS is installed on the base plate or in the enclosure (BD FACSCanto II 
only). Sheath and waste travel between the cytometer and the HTS via 
connectors in the cytometer interface panel. The power cable, communication 
cable, and door sensor cable (BD FACSCanto II only) that connect to the HTS 
can be found at the cytometer interface panel. See Figure 1-8 to Figure 1-11 for 
the connection points for the HTS and see Installing the HTS on page 179 for 
detailed instructions.

Figure 1-8  Cytometer interface panel (BD LSR II) 

Waste tubing
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Figure 1-9  Cytometer interface panel (BD LSRFortessa)

Figure 1-10  Cytometer interface panel (BD FACSCanto)

HTS base plate

Sheath tubing

Waste tubing

Communication cable

Power cable

SIT

Communication
cable

Waste tubing

Sheath 
tubing

Power cable

Base plate



 Chapter 1: System Overview 23

Figure 1-11  Cytometer interface panel (BD FACSCanto II) 
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Tube/Plate Acquisition Mode Switch

The BD LSR II and BD LSRFortessa interface panels also include an acquisition 
mode switch.

Figure 1-12  Tube/plate acquisition mode switch for HTS

• In Tube mode ( ), the droplet containment module (DCM) vacuum 
functions normally—the vacuum is on when the arm is positioned to the 
side and off when the arm is centered. Backdripping from the SIT is 
contained when the DCM sleeve is installed.

• In Plate mode ( ), the DCM vacuum on the cytometer is disabled. Drip 
containment is provided by the absorbent pad in back of the HTS 
(Figure 1-6 on page 18).

Tube

Plate
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Figure 1-13  Tube/plate acquisition mode switch on the BD LSR II flow cytometer

Figure 1-14  Tube/plate acquisition mode switch on the BD LSRFortessa flow cytometer

Tube/plate acquisition mode switch

Tube/plate acquisition 
mode switch
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Sample Coupler

A sample coupler connects the injection port tubing on the HTS to the cytometer 
SIT (Figure 1-19 on page 33). 

For the BD LSR II and BD LSRFortessa, the DCM sleeve is replaced by the SIT 
protector. The SIT protector is a modified sleeve that prevents the sample 
injection tube from bending during installation of the HTS sample coupler.

For the BD FACSCanto and BD FACSCanto II, the sample coupler is installed on 
the SIT, while the aspirator arm rests against the sample coupler. Flip the 
aspirator arm bar to the back (as shown in Figure 1-19 on page 33) to ensure 
that it does not come in contact with the HTS probe. This position also ensures 
that the aspirator arm is able to detect an installed sample coupler.

Biohazardous Waste

When you are not acquiring samples using the HTS, install the DCM sleeve and 
switch the cytometer to tube mode. For more information, see Setting Up for 
Tube-Based Acquisition on page 103.

While connecting or disconnecting the HTS, backdripping from the SIT is 
contained by the absorbent pad in the rear of the HTS.
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Figure 1-15  HTS absorbent pad on the BD LSRFortessa flow cytometer

SIT
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Setting Up for Plate-Based Acquisition

This section describes how to set up the cytometer for plate-based acquisition. 
When switching from tube mode to plate mode, you need to place the acquisition 
mode switch in plate mode, replace the DCM sleeve with the SIT protector, and 
connect the sample coupler.

Setting Up for Plate-Based Acquisition (BD LSR II 
and BD LSRFortessa)

To switch from tube mode to plate mode:

1 If necessary, install the HTS.

See Installing the HTS on page 179.

2 Set the acquisition control switch to plate mode ( ).

3 Unscrew the tube retainer that holds the DCM sleeve onto the SIT and 
carefully remove the sleeve.

Any cytometer surface that comes in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when handling 
cytometer hardware. Wear suitable protective clothing and gloves. For 
instrument precautions, see Biohazardous Waste on page 26.
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4 Install the SIT protector.

a Slide the protector over the SIT and push up on the tube retainer until 
you can screw it onto the SIT. 

b Tighten the tube retainer.

5 Carefully attach the HTS sample coupler to the cytometer SIT.

a Move the aspirator arm to the left.

Tube retainer

DCM sleeve

Tube retainer

SIT protector
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b Slide the sample coupler onto the SIT until you reach a hard stop. 
Make sure the sample coupler tubing is not kinked or twisted. 

c Hold the coupler with one hand while you tighten the top nut with the 
other hand.

There should be a gap between the tightening nut and the bottom of 
the SIT protector (Figure 1-16 on page 30). If you do not see a gap, 
unscrew the tube retainer, push the SIT protector all the way up, and 
retighten the tube retainer.

d Make sure the sample coupler is securely connected to the SIT.

Figure 1-16  Installing the sample coupler on the BD LSR II or BD LSRFortessa

6 Turn on the HTS.

The power switch is on the right side of the HTS. See Figure 1-17.

Gap

SIT protector

Tightening nut

Sample coupler

BD LSR II BD LSRFortessa
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Figure 1-17  Power switch (BD LSR II flow cytometer)

Figure 1-18  Power switch (BD LSRFortessa flow cytometer)

NOTE (BD LSR II and BD LSRFortessa) Soft standby mode is not 
available when you are acquiring samples in plate mode. See your 
cytometer user’s guide for information about soft standby mode. 

power switch Power switch

Power switch
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Setting Up for Plate-Based Acquisition 
(BD FACSCanto and BD FACSCanto II)

To switch from tube mode to plate mode:

1 Turn on the cytometer and the HTS.

(BD FACSCanto) Turn on the cytometer, followed by the HTS. 

(BD FACSCanto II) The HTS turns on automatically when the cytometer is 
powered on.

2 Remove/open the HTS safety cover.

(BD FACSCanto) Tilt the front of the cover up, then slide the cover forward 
to remove it.

(BD FACSCanto II) Slide open the covers. Slide the front cover to the left 
and slide the side cover to the back.

3 Perform a sheath fluid exchange. 

See Exchanging the Sheath Fluid (BD FACSCanto and BD FACSCanto II) 
on page 107.

4 Attach the HTS sample coupler to the cytometer SIT.

a Move the aspirator arm to the left. 

b Slide the sample coupler onto the SIT until you reach a hard stop. 
Make sure the sample coupler tubing is not kinked or twisted. 

c Hold the coupler with one hand while you tighten the top nut with the 
other hand.

d Allow the aspirator arm to rest against the sample coupler.

NOTE Flip the aspirator arm bar backwards to ensure that it does not 
come in contact with the HTS probe.
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Figure 1-19  Installing the sample coupler on the BD FACSCanto or BD FACSCanto II

5 Make sure the sample coupler is securely connected to the SIT and prime 
the HTS twice by selecting HTS > Prime.

Sample coupler

Aspirator arm bar 
(moved toward the 
back)BD FACSCanto BD FACSCanto II
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Acquisition Sampler Modes

During acquisition, the HTS processes samples differently based on the 
throughput mode. Table 1-2 compares acquisition in each mode.

Table 1-2  Comparison of acquisition sequence in standard and high-throughput mode

Sequence Standard mode High-throughput mode

1 • Raises the probe to the cleaning 
position

• Flushes the probe using the 
primary pump

• Turns on the waste pump

• Raises the probe to the cleaning 
position

• Flushes the probe using the 
primary pump

• Turns on the waste pump

2 • Raises the probe

• Refills the primary pump

• Turns off the waste pump

• Draws a separator bubble into the 
tip of the probe

• Raises the probe

• Refills the primary pump

• Draws a separator bubble into the 
tip of the probe

3 Moves the probe and the plate holder 
so the probe is positioned above the 
required well

Moves the probe and the plate 
holder so the probe is positioned 
above the required well

4 Lowers the probe and mixes the 
sample

Lowers the probe and mixes the 
sample

5 Aspirates the requested sample 
volume plus 20 µL of aspirated excess 
volume (required by the system) 
along with a separator bubble

• Aspirates a fixed volume of 22 µL 
of mixed sample (independent of 
the sample volume entered in the 
software) along with a separator 
bubble

• Turns off the waste pump

6 Moves the probe up, over, and down 
into the injection port

Moves the probe up, over, and down 
into the injection port
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Loader Settings

Sample Well Volumes

There are different volumes to take into consideration when choosing loader 
settings. Figure 1-20 shows different well volumes and Table 1-3 defines each 
volume type.

7 A non-selectable, fixed boost 
command transports sample to the 
flow cell to prime the sample flow 
path

A non-selectable, fixed boost 
command transports sample to the 
flow cell to prime the sample flow 
path

8 When the boost command is done, 
BD FACSDiva software begins 
acquiring the sample

• When the boost command is 
done, delivers the sample to the 
flow cell using the secondary 
(high-throughput) pump

• BD FACSDiva software begins 
acquiring the sample

• Simultaneously raises the probe to 
the cleaning position and the 
primary pump begins processing 
the next well in parallel to 
acquisition

9 After the last well in a sequence, 
raises the probe to the cleaning 
position and performs a final flush 
and refill 

After the last well in a sequence, 
raises the probe to the cleaning 
position and performs a final flush 
and refill

10 Lowers the probe into the injection 
port/wash station

Lowers the probe into the injection 
port/wash station

Sequence Standard mode High-throughput mode
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Figure 1-20  Well volumes

Mixing

HTS mixing efficiency is impacted by the viscosity of the sample in the well. 
Adjust the mixing volume, speed, and the number of mixes to obtain the most 
homogeneous population for acquisition.

Table 1-3  Volume type

Volume type Definition

Well volume Volume that well can hold filled to the brim

Dispensed volume Volume pipetted into well minus aspirated excess volume

Aspirated excess 
volume

Standard mode = 20 µL

Available volume Volume pipetted into well minus aspirated excess volume minus 
dead volume

Minimum volume 50 µL for both standard and high-throughput modes for 96-well 
plates

Mixing volume Approximately one-half the available volume

NOTE   A mixing volume that is larger than the available volume 
introduces air bubbles into the sample

Dead volume Volume in the bottom of the well that the probe cannot reach

Sample volume Amount of sample requested for analysis in BD FACSDiva software

Available volume

Plate-dependent dead volume

Total volume 

Well

Sample probe
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A greater number of mixes might allow you to decrease the mixing volume and 
speed, but this could impact sample throughput. Increasing the mixing speed and 
volume might improve throughput and mixing efficiency, but it could also 
introduce air bubbles in the sample well. In addition, increased mixing speed 
could compromise the separator bubble between the sample and sheath, resulting 
in sporadic event rates and possibly higher carryover.

Use default values as a starting point (see Table 2-4 on page 54) with a mixing 
volume of one-half the total sample volume. Note that samples are mixed less 
effectively in flat-bottom wells than U- or V-bottom wells. When using flat-
bottom wells, you might want to mix the sample well before pipetting it into the 
plate, and acquire the sample before it has a chance to settle.

Carryover

You can vary the amount of wash volume to minimize carryover. In general, a 
greater wash volume results in less carryover, but the greater the volume, the 
slower the system throughput. 

The minimum volume is determined by the sample and mixing volume. To start 
with, try a 400-µL wash for 10 µL of sample volume. As the sample and mixing 
volumes decrease, the wash volume can also be reduced.

Throughput

The speed at which the HTS completes a plate depends on the acquisition time 
(sample volume/sample rate), acquisition mode (high throughput or standard), 
mixing volume and speed, number of mixes, and wash volume. To achieve 
optimal throughput, we recommend that you concentrate the sample, reduce the 
sample volume (10 µL or less), increase the sample rate (1 µL/sec or greater), 
minimize the number of mixes (2 or less), and decrease the wash volume (400 µL 
or less).

NOTE The BD FACSCanto II maximum event rate is 10,000 events/second.
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2

BD FACSDiva Software Overview

This chapter describes the BD FACSDiva software features necessary to operate 
the HTS with the BD LSR II, BD LSRFortessa, BD FACSCanto, and 
BD FACSCanto II flow cytometers. For an in-depth description of software 
components not described in this chapter, see the BD FACSDiva Software 
Reference Manual.

The following topic is covered in this chapter:

• Workspace Components on page 40
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Workspace Components

When you start BD FACSDiva software, the workspace opens. Windows 
containing the main application components are displayed within the workspace. 
Display additional windows by clicking buttons on the Workspace toolbar. The 
workspace components (Figure 2-1) are described in the following table.

Figure 2-1  BD FACSDiva workspace displaying an open experiment and the Plate window

1

2

4

3

5

6
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The following table describes some of the more common workspace components 
specific to running the HTS. 

Number Common Workspace Components

1 Use the commands in the menu bar to operate the software. 

• Use the Experiment menu to add a new experiment to the Browser or 
open a template. A new experiment automatically contains global 
cytometer settings and a global worksheet. For information, see Creating 
Experiments on page 72.

• Use the commands in the HTS menu to perform maintenance procedures 
on the HTS. For information, see Maintenance on page 111.

2 Click a button on the Workspace toolbar to hide or show the corresponding 
window. 

Windows can be resized by dragging a border or corner. Click the Plate 
button ( ) to view the Plate window. 
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3 • Use the Browser window to create and set up experiments and view 
experimental data hierarchically.

In the Browser, double-click an experiment to open it.

• Click the New Experiment button ( ) on the Browser toolbar to create 
a new experiment.

• Click the New Plate button ( ) on the Browser toolbar to add a 
default 96-well U-bottom plate to the open experiment.

• Click the arrow next to the New Plate button ( ) to select a new 
plate type to add to the experiment.

The type you select becomes the default.

Number Common Workspace Components

96-well U-bottom plate

Closed
experiment

Current tube
pointer

Open
experiment

Browser
toolbar

96-well flat-bottom plate

96-well V-bottom plate

384-well flat-bottom plate
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4 Use the Acquisition Dashboard to acquire and record well data. Use the 
Plate controls to acquire and record wells in sequence using the selected 
throughput mode. Run Plate runs the wells from the current position to the 
end of the plate. Run Well(s) runs the selected wells only. 

Use the Basic Controls to manually acquire or record selected wells in 
standard mode using the current loader settings.

You can expand (show) and contract (hide) the Acquisition Dashboard.

To show or hide the Plate Controls, Acquisition Setup, or Acquisition Status 
sections of the Acquisition Dashboard, right-click the Acquisition 
Dashboard in any blank area (except for Basic Controls) and select a section 
to show or hide from the shortcut menu.

You can resize the Acquisition Dashboard using standard Windows 
methods.

Number Common Workspace Components
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5 Use the Inspector to view or modify the 
attributes of a single object or set of 
objects on the worksheet or plate, or in 
the Browser. The contents of the 
Inspector change depending on what is 
selected in the workspace.

The Inspector can be used to view or 
change HTS (Loader) settings. See 
Loader Settings on page 51.

6 Set up, acquire, and analyze plate-based experiments in the Plate window. 
Use this window also to select the throughput mode and adjust loader 
settings.

Number Common Workspace Components
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Plate Window

Most of the features for running plate-based experiments on the HTS are located 
in the Plate window (Figure 2-2 on page 45). The tabs at the top of the Plate 
window represent views that organize the workflow for the plate. The Setup view 
is for setting up the experiment and the cytometer, adjusting cytometer settings, 
and acquiring and analyzing samples from a plate. The Analysis view is for 
assigning keywords to wells and analyzing data after a run. The Plate window is 
available when an experiment is open and you double-click the plate in the 
Browser. 

Figure 2-2  Setup view of the Plate window

See the following sections for a description of components in, and the 
functionality of, each view.

View tabs

Plate toolbar

Plate layout

Throughput
mode
Loader status

Specimen list

HTS settings

Plate legend/
filter

Baseline restore
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Setup View Components

The Setup view contains controls for designing experiments, running plate-based 
acquisition, and monitoring acquisition status. For instructions on setting up an 
experiment, see Creating Experiments on page 72. All entries made in the Setup 
view can be saved as a template, either for general projects or as a default 
experiment for a user-defined project. 

The following components are available in the Setup view.

Plate Filter

The Filter Setup Details area provides a legend indicating the type of specimens in 
the plate and allows you to filter (hide or show) acquisition order, specimen 
number, specimen settings, and/or well settings.

Clear the checkbox next to acquisition order, specimen number, specimen 
settings, and/or well settings to hide the symbol in the plate layout.

Icon Category Description

Specimen type Indicates the type of control or sample assigned to a 
given well. The pink square represents a setup control, 
the purple square a compensation control, and the blue 
circle a specimen.

First well in group A dark blue square appears for the specimen number in 
the upper-right corner of the first well for each specimen.

Acquisition order The order (sequence number) in which each well will be 
acquired appears with a green background in the 
bottom-right corner of the well.

Specimen number The specimen number appears in the upper-right corner. 
Each well belonging to the same specimen has the same 
specimen number.



 Chapter 2: BD FACSDiva Software Overview 47

Plate Toolbar

The Plate toolbar contains the following buttons. 

Specimen settings When cytometer settings are added to a specimen, the 
cytometer settings icon appears in the upper-left corner 
of the well.

Well settings When cytometer settings are added to a well, the 
cytometer settings icon appears in the lower-left corner 
of the well.

Icon Command Name Description

Add Setup 
Controls 

Select a well or group of wells, then click the Add Setup 
Controls button to add well(s) to the plate layout for 
adjusting cytometer settings. The wells are for setup only, 
and are not recorded.

Add Specimen 
Wells 

Select a well or group of wells, then click the Add 
Specimen Wells button to add a specimen to the plate 
layout. Wells are run in the order they are selected.

Add Well Select a well that has already been defined, then click the 
Add Well button to add another sample or set up a 
control well. The new well is inserted to the right of or 
below the selected well.

Click the arrow to the right of the Add Well button to 
select a horizontal or vertical orientation, depending on 
whether you want to add the new well to the right of or 
below the selected well.

Icon Category Description
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Plate Layout

The plate layout is a representation of a multiwell plate. The plate layout in the 
Setup view is where you add samples, setup controls, and cytometer settings to 
the plate. You can also copy and paste HTS settings, rearrange samples, add 
wells, assign keywords, and set recording rules. Once you have set up the plate 
layout, you can print the view to use as a guide when adding samples to the 
multiwell plate. For information on the functions you can perform in Setup view, 
see Setup View Functions on page 56.

The plate layout in the Setup view displays the run sequence and status of each 
well. 

• Wells are numbered according to sample type (setup controls first, 
compensation controls second, specimens last), and then the order 
assigned. 

• During setup or acquisition, wells are colored according to their status. 
See Table 2-1.

Add Cytometer 
Settings 

Select a well, then click the Add Cytometer Settings 
button to add cytometer settings to the sample. The 
Cytometer Settings icon ( ) is added to the well in the 
bottom-left corner. Select a specimen from the specimen 
list, then click the Add Cytometer Settings button to add 
cytometer settings to the selected specimen. The 
Cytometer Settings icon is added to the first well in the 
top-left corner.

Print Click the Print button to print the Setup view. To save a 
record of acquisition status for each well, print the Setup 
view after acquisition is complete. The printout contains 
the plate name, plate type, name of the view, and legend 
that indicates well status. For more information on well 
status, see Plate Layout on this page and Table 2-2 on 
page 50.

Icon Command Name Description
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• After acquisition is complete, wells are colored according to acquisition 
status. See Table 2-2 on page 50.

The basic layout of each well appears as follows: 

    

Table 2-1  Assessing well status during setup or acquisition

Well Status

Selected for acquisition

Selected for acquisition and contains previously recorded data

Acquiring

Recorded

Selected for acquisition and contains previously recorded data 
from aborted runa

a. The error message is cleared from the Status tab of the Cytometer Settings window when acquisition begins.

Selected for acquisition, aspirated, and aborteda

Acquisition order

Specimen/control group ID 
and indicator or first well in 
group

Specimen-level cytometer
settings placeholder

Well-level cytometer
settings placeholder
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Compensation Controls

You can create label-specific compensation controls. See the BD FACSDiva 
Software Reference Manual for information.

Throughput Mode

The default mode at startup is high throughput. 

Select throughput mode by clicking the corresponding mode button in the Setup 
view. You can also select the throughput mode in the Plate Inspector.

Table 2-2  Assessing well status once acquisition is complete

Well Status

Well contains data—acquisition successful

Well contains no data

Well contains data—recording aborted

Well contains no data—acquisition aborted

To keep a record of acquisition status, print a copy of the Setup view 
immediately after acquisition is finished, and refer to the printout if you 
reanalyze or export the data. If you export a data file or experiment that 
contains incomplete data, the software cannot recognize that the file is 
incomplete.
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Default acquisition settings and limits change when you switch between standard 
and high throughput mode, so select the mode first when setting up a plate.

NOTE The throughput mode applies to the entire plate, so all wells on the plate 
are acquired in the same mode, except for setup and compensation control wells, 
which are always run in standard mode.

The following acquisition times can be achieved with the settings specified in 
Table 1-1 on page 14.

• In high-throughput mode, the HTS can process a 96-well plate in 
approximately 15 minutes.

• In standard mode, the HTS can process a 96-well plate in approximately 
44 minutes.

For details on how the HTS acquires samples in each mode, see Acquisition 
Sampler Modes on page 34.

Loader Status

Monitor status messages for the HTS Loader during acquisition by viewing the 
Loader status field. For Loader errors, see HTS Troubleshooting on page 154.

Loader Settings

The loader (HTS) settings shown in the Setup view are the current settings for the 
selected well or plate. You can modify these settings in either the Setup view or 
the Well Inspector. Default loader settings are provided for each throughput 
mode. You will need to optimize these settings for the plate type and assay you 
are running. You cannot change HTS settings during acquisition or when a 
sequence is in process.

NOTE If multiple wells with different loader settings are selected, a red highlight 
appears around the loader settings that are different.
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Table 2-3  HTS loader settings 

Loader Setting Description

Sample flow rate Speed that the syringe aspirates sample from the well in µL/second.

To determine the acquisition time, divide the sample volume by the 
sample rate:

Sample volume Volume of sample aspirated from each well for acquisition.

During acquisition in standard mode, the HTS aspirates 
the selected sample volume (2–200 µL) plus an additional 
20 µL from the well. During acquisition in high 
throughput mode, the HTS aspirates a fixed 22 µL per 
well even though you can select a sample volume between 
2–10 µL.

Make sure each well contains sufficient sample for the 
entered volume plus the dead volume. Insufficient volume 
can introduce air bubbles into the system.

To make sure you do not run out of sample, we 
recommend that you prepare your plate with a minimum 
of 250 µL of sample/well for a 96-well plate in standard 
mode, 100 µL/well for a 96-well plate in high-throughput 
mode, and 50 µL/well for a 384-well plate (either mode).

Acquisition time (sec) = Sample volume (µL)
Sample rate (µL/sec)
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Mixing volume Volume of sample aspirated and dispensed during mixing.

Make sure each well on your plate contains sufficient 
sample for mixing. Insufficient volume can introduce air 
bubbles into the system. We recommend a mixing volume 
that is one-half the available volume. See Loader Settings 
on page 35, Sample Well Volumes on page 35, and Mixing 
on page 36.

Adequately mix the sample before pipetting it into the 
plate. Use the mixing cycle only to maintain a 
homogeneous particle suspension.

Mixing speed Speed that the syringe aspirates sample from and dispenses sample 
to the well during mixing.

Number of 
mixes

Number of mixing cycles that are performed before a sample is 
aspirated.

Wash volume Volume of sheath fluid dispensed for rinsing between wells.

Baseline restore At the start of data acquisition, only when data is recorded, 
BD FACSDiva software version 7.0 or later ignores the initial data 
for a period of time. That period of time is defined by the baseline 
restore (BLR) period.

BLR functionality is only available on BD FACSCanto, BD LSR II, 
and BD LSRFortessa cytometers with the HTS. The default state 
for BLR is off. BLR works in both standard and high throughput 
modes.

To set the BLR period:

1 Select one or more wells.

2 Select the Enable BLR checkbox.

3 Set the BLR time within the minimum and maximum period of 
5–150.

The software multiplies the BLR period by 10 to set the time in 
milliseconds. For example, setting the BLR period to 5 equates 
to a delay of 50 milliseconds before recording data.

Note that when you type in a value, you need to press the Enter 
key for the value to be saved.

Loader Setting Description
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Table 2-4  HTS settings for standard and high-throughput modes

NOTE A mixing volume greater than the available volume introduces air bubbles 
into the sample.

Shortcut Menu

Right-click a well in the plate layout to open the shortcut menu. From the 
shortcut menu, you can:

• Cut, copy, and paste wells, cytometer settings, loader settings, and spectral 
overlap

• Delete wells and settings

• Export settings, analysis templates, and FCS files

• Import cytometer settings

• Apply analysis templates

• Apply and save cytometer settings

Setting Standard Mode
High-Throughput 

Mode

Default Range Default Range 

Sample flow rate (µL/sec) 1 0.5–3.0 1 0.5–3.0

Sample volume (µL) 10 2–200 2 2–10

Mixing volume (µL)a

a. We recommend a mixing volume that is one-half the available volume. See Loader Settings on page 35, 
Sample Well Volumes on page 35, and Mixing on page 36.

100 5–100 50 5–100

Mixing speed (µL/sec) 180 25–250 200 25–250

Number of mixes (cycles) 2 0–5 2 0–5

Wash volume (µL) 400 200–800 200 200–800
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• Link to a setup

• Apply compensation controls

• Apply and save application settings

• Create an experiment layout

For additional information about these commands, see the BD FACSDiva 
Software Reference Manual.

Renaming Specimens in a Plate

To rename specimens in plate view:

1 In the Plate View window, click once to select the specimen name in the list 
of specimens on the plate.

2 Click the name once more to enter the new name for the specimen.

3 Press Enter.

Cut, Copy, and Paste Features

You can copy and paste well setup and elements to a blank well. The pasted wells 
inherit the loader and cytometer settings from their respective sources. This does 
not apply to the compensation controls specimen because it is unique to the 
experiment.

To copy and paste wells:

1 In Plate View, select the wells to be copied.

2 From the shortcut menu, select Copy > Well(s).
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3 Click the down arrow ( ) to set the paste direction to horizontal or 
vertical.

This automatically adds a new well to the existing specimen in the direction 
selected.

Or, to paste to a different area of the plate and make a new specimen, select 
an empty well. From the shortcut menu, select Paste > Well(s).

To copy and paste a specimen:

1 Click the specimen in the list of specimens on the plate.

2 Right-click a well in that specimen, then select Copy. 

3 Select an empty well, then right-click it and select Paste. 

If there is room on the plate, the specimen will be pasted.

Setup View Functions

Use the Setup view to set up new plate-based experiments. Once you have added 
setup controls, samples, and cytometer settings to the plate layout, you can assign 
keywords, set recording rules, apply a selected assay (analysis template), and 
copy and paste HTS (loader) settings to selected wells or to the entire plate.

Use the Setup view to perform the following functions:

• Define loader settings

• Optimize cytometer settings while running setup controls

• Monitor well status during acquisition

• Acquire and record wells manually or automatically

• Analyze plate data
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Rearranging Samples on the Plate

Rearrange samples and wells in the plate layout by using the Cut, Copy, and 
Paste functions. Note that specimens and wells cannot be overwritten.

• You can move specimens to different locations in the plate layout as long as 
there is room to accommodate the entire specimen. 

• You can move wells within a specimen to change the acquisition order or 
move wells from one specimen to another. Wells are pasted either below or 
to the right of the selected well, depending on the orientation of the Add 
Well button.

Assigning Keywords

You can create and assign keywords at the experiment or well level. For 
information on creating experiment keywords, see the BD FACSDiva Software 
Reference Manual. For instructions on creating and assigning keywords at the 
well level, see Assigning Keywords on page 86.

Setting Recording Rules

You can alter the acquisition stopping criteria for a selected well by:

• Changing the sample flow rate and sample volume in the HTS tab of the 
Well Inspector.

• Changing the events to record in the Experiment Layout or Acq tab of the 
Well Inspector.

For information on acquisition stopping criteria, see Running Samples 
Automatically in Sequence on page 59 and Running Wells Manually on page 61.
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Applying an Analysis Template

You can apply an analysis template to selected samples or wells. First select the 
well, then either:

• Select Edit > Apply Analysis Template from the menu bar.

• Right-click and select Apply > Analysis Template from the shortcut menu.

For instructions on how to save an Analysis template, see Exporting an 
Experiment as a Template on page 93.

Applying HTS Settings

Apply specific HTS settings to a well or group of wells by using the Copy/Paste 
Loader Settings commands in the shortcut menu.

Copying and Pasting Cytometer Settings

You can copy and paste cytometer settings from one specimen or well to another 
as long as the specimen or well that you are copying from has cytometer settings. 
You can copy and paste cytometer settings to and from unrecorded wells only. 

To copy settings from one specimen to another:

1 Click to select the specimen in the specimen list (see Figure 2-2 on page 45). 

2 Right-click the selected specimen on the plate and select Copy Cytometer 
Settings. 

3 Select the specimen you want to copy to in the specimen list.

4 Right-click the selected specimen on the plate and select Paste Cytometer 
Settings.

To copy settings from one well to another:

1 Click a well to select it.
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2 Right-click the well and select Copy Cytometer Settings. 

3 Select the well you want to copy to.

4 Right-click and select Paste Cytometer Settings.

Acquisition Mode

There are two ways to run plate-based acquisition on the HTS: automatically in 
sequence or manually one well at a time. See Running Samples Automatically in 
Sequence in the following section and Running Wells Manually on page 61 for a 
description of each mode.

Running Samples Automatically in Sequence

When running samples in sequence, use the HTS controls in the Acquisition 
Dashboard. Data collection proceeds automatically according to sequence 
number. 

Select noncontiguous samples by holding down the Ctrl key while clicking 
individual specimens, or select a range of samples using the mouse. Wells are run 
in the following order:

• Setup controls

• Compensation controls

• Specimen wells

NOTE When a sequence is in progress, the ability to select a well in the plate 
layout is disabled. 

During a sequence, the acquisition buttons have the following function:

• Run Plate/Stop Plate toggle button. Starts recording data for all wells in the 
plate or terminates the sequence after recording data for the current well. 
The system flushes any remaining sample that was aspirated. 
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• Run Well(s)/Stop Well(s) toggle button. Starts recording for all wells 
selected in the sequence or terminates the sequence after recording data for 
the current well. The system flushes any remaining sample that was 
aspirated. 

• Pause/Resume toggle button. Pauses the sequence after finishing collection 
of the current well or resumes a paused sequence with the next well in the 
sequence.

During an uninterrupted sequence, BD FACSDiva software calculates the 
acquisition time of each well based on sample volume. This acquisition time is 
referred to as the stopping time, and is calculated as follows:

The software stops acquisition or recording of a well and proceeds to the next 
well when any of the following stopping rules have been met:

• The specified number of events have been collected

• The stopping time has been reached

• The file has exceeded memory specifications. See the BD FACSDiva 
Software Reference Manual for more information.

NOTE If an HTS error occurs during a run, the run aborts and an error message 
displays. Once the sequence run is complete, a dialog is displayed with the status 
of the run and whether any errors occurred. An alert sounds until the dialog is 
closed.

Stop time (msec) = Sample volume (µL)
Flow rate (µL/sec) x 1 sec/1,000 msec
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Running Wells Manually

When running samples in manual mode, use the Basic Controls in the Acquisition 
Dashboard. You can acquire, record, and restart acquisition on a single selected 
well as long as a sequence is not currently running. For detailed information on 
the basic acquisition controls, see the BD FACSDiva Software Reference Manual.

To start manual mode, do one of the following:

• Click a well, then click Acquire Data under Basic Controls to start 
acquisition.

• Click a well, then click Record Data under Basic Controls to start 
recording data.

NOTE While running plate-based acquisition, the Start Acquisition on pointer 
change preference in the User Preferences window is ignored and the software 
proceeds as if the preference were set to Off.

NOTE During manual acquisition, high-throughput mode is not applicable.

Stopping time in manual acquisition mode is calculated the same as in automatic 
sequence mode. The software stops acquisition or recording of a well when any 
of the following stopping rules have been met:

• The specified number of events have been collected

• The stopping time has been reached

• The file has exceeded memory specifications. See the BD FACSDiva 
Software Reference Manual for more information.

• Acquisition was stopped by clicking the Stop Acquiring button under Basic 
Controls

Once acquisition of the well is complete, any remaining sample is flushed from 
the system. The controls in the Acquisition Dashboard are briefly disabled while 
the loader is reset.
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Analysis View Components

The Analysis view provides an interface for:

• Displaying keyword results in the plate layout

• Reviewing and analyzing data collected from a plate 

• Starting a batch analysis 

For information on performing these functions, see Analysis View Functions on 
page 65.

The following components are available in the Analysis view.

Plate Layout

The plate layout in the default Analysis view displays the acquisition status of 
each well. See Table 2-2 on page 50 for status indicators.
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Figure 2-3  Plate layout showing Keyword Analysis view

Add Keyword Button

Click the Add Keyword button ( ) to bring up the Add Keywords dialog 
(Figure 2-4). The Available Keywords list displays all keywords that were used in 
the experiment. To assign new keyword, see Assigning Keywords on page 86. To 
view keywords in the Analysis view, you must add the Keywords to the Selected 
Keywords list. For complete instructions, see Displaying Keywords on page 95.

Keyword listAdd Keyword button
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Figure 2-4  Add Keywords dialog

Print Button

Click the Print button ( ) to print the Analysis view. To save a record of 
analysis, print this view after analysis is complete. The printout shows the plate 
layout, legend with keywords, and plate name and type.

Keywords List

The Keywords list contains the selected keywords for all samples and wells on the 
plate (Figure 2-3). A maximum of 15 keywords can be added to the list. Add 
keywords to the list by clicking the Add button. See Add Keyword Button on 
page 63 for more information.

Current Tube Pointer

To analyze a well in the Analysis view, click the well to select it. The well is 
outlined in blue, indicating that the well is selected for analysis. In the Browser, 
the current tube pointer appears to the left of the plate name. See Figure 2-5 for 
an example. 
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Figure 2-5  Analysis indicators

Shortcut Menu

Right-click a selected well at the Analysis view to open the shortcut menu. The 
following commands are available in the shortcut menu.

Analysis View Functions

Perform the following functions in the Analysis view:

• Display keywords in plate layout

• Analyze plate data

• Perform batch analysis

Current plate or
tube pointer

Selected well in
Analysis view
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Displaying Keyword Results in the Plate Layout

If keywords were assigned to the plate, clicking on a keyword in the Keywords 
list toggles the plate layout to show the Keywords Analysis view. Each keyword is 
shown as a different color. If a keyword was assigned a range of values, a value is 
displayed in each well. Different values of the same keyword are shown in 
various shades of the keyword color. If a well has no value assigned, the well is 
white. To revert back to the default Analysis view, click the keyword in the 
Keywords list.

Use the Keyword Analysis view to display keyword values for all wells that were 
assigned the selected keyword. The Keyword list displays all keywords that were 
used in the current experiment. When you select a keyword, the plate layout 
shows keyword values and corresponding background colors. Wells are colored 
according to keyword assignments.

For example, Figure 2-6 displays values for the keyword Concentration. In this 
example, four different concentrations were assigned to wells on the plate. The 
Keyword Analysis view shows the concentration value assigned to each well.

Figure 2-6  Keyword Analysis view



 Chapter 2: BD FACSDiva Software Overview 67

Analyzing Plate Data 

Analyze plate data the same way you would analyze tube data. For detailed 
information, see the BD FACSDiva Software Reference Manual.

Performing Batch Analysis

Use the batch analysis feature to automatically advance a selected set of data for 
multiple wells through an analysis template on a global worksheet. You can also 
assign a preferred global worksheet to a specimen or individual wells using the 
Inspector. You can set up batch analysis to pause between each data file and to 
print a copy of the analysis before proceeding with the next well.

NOTE To perform batch analysis, you must view data using a global worksheet.

For an example of setting up and performing batch analysis, see Performing 
Batch Analysis on page 99.
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3

Running Samples

This chapter describes how to set up for plate-based acquisition and acquire 
samples using the HTS. For general information about the software, see 
Chapter 2.

NOTE You can automate your plate run in BD FACSDiva 7.0 software. For 
details, see Automation on page 188.

NOTE If you are running the system for the first time, we recommend that you 
practice running a sample plate using BD Calibrite™ beads or a similar control 
sample. 

The following topics are covered in this chapter:

• Starting Up on page 70

• Creating Experiments on page 72

• Preparing for Acquisition on page 87

• Performing Compensation on page 89

• Acquiring Data on page 91

• Analyzing Data on page 95
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• Setting Up for Tube-Based Acquisition on page 103

• Shutting Down on page 109

Starting Up

This section describes how to start up the cytometer, software, and HTS. Notice 
that some steps apply only to specific cytometers.

NOTE If you need to install the HTS, follow the procedures in Installing the HTS 
on page 179.

1 Start up the flow cytometer as described in the appropriate cytometer 
manual.

Make sure to refill the sheath container and empty the waste container. 

For BD FACSCanto and BD FACSCanto II systems, if a full waste 
container is detected at the start of or during a run, the run is stopped. If 
necessary, perform a sheath fluid exchange to use the appropriate sheath 
solution. See Exchanging the Sheath Fluid (BD FACSCanto and 
BD FACSCanto II) on page 107.  

To prevent bubble formation in the flow cell, use only BD FACS™ sheath 
solution with surfactant (BD Catalog No. 336524 (US) or 336911 
(Europe)) when acquiring samples with the HTS. This sheath solution is 
intended for research use only, and should be used only with the HTS. It 
should not be used for sorting or for in vitro diagnostic (IVD) applications. 
See the product insert for more information.

Add 500 µL of Sigma® Antifoam A Concentrate to the waste tank to 
prevent foaming of potentially biohazardous waste up around the cap. Mix 
the Antifoam Concentrate in distilled water to force it into the solution 
before adding it to the waste tank. Add the Antifoam Concentrate in 
addition to bleach.
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2 Turn on the HTS.

NOTE The HTS turns on automatically for the BD FACSCanto II.

3 Ensure that the sample coupler is installed. 

See details under Setting Up for Plate-Based Acquisition on page 28.

4 (BD LSR II and BD LSRFortessa) Place the cytometer in Run mode. 

5 Start up the computer and start BD FACSDiva software. 

6 At the Log In dialog, select your user name, enter your password, and click 
OK.

For instructions on creating a user name and password, see the 
BD FACSDiva Software Reference Manual.

7 Verify that the software connects to the cytometer. If the software does not 
connect, select Cytometer > Connect.

View the connectivity status at the bottom of the Cytometer window. The 
software detects the HTS and automatically runs an initialization sequence.

8 After the initialization sequence has finished, select HTS > Prime.

9 Run the HTS prime sequence 2 to 3 times.

10 (BD LSR II and BD LSRFortessa) When the prime sequence is complete, 
return the cytometer to Standby mode.

Do not allow the system to run dry, as this could damage the HTS pumps.

Verify that no other software applications are running before you start 
acquisition. BD FACSDiva software performance time can be severely 
affected if multiple applications are running at the same time.
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11 (BD FACSCanto and BD FACSCanto II) Perform a fluidics startup.

a Select Cytometer > Fluidics Startup.

A confirmation dialog opens.

b Click OK to begin fluidics startup.

When fluidics startup is done, a completion dialog opens.

c Click OK.

Creating Experiments

An experiment is a group of elements used to acquire and analyze data from the 
HTS. The Browser is where you create experiments and access stored data.

Here are two ways to add experiments to the Browser:

• Click the New Experiment button ( ) on the Browser toolbar to create a 
new, empty experiment with default experiment elements and default 
cytometer settings.

• Select Experiment > New Experiment to create a new experiment based on 
a saved template with customized elements such as plots, gates, statistics 
views, and cytometer settings.

The following tutorials describe how to set up an experiment specifically for 
plate-based acquisition and how to create additional experiments.
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Creating a Folder and an Experiment

This section describes how to create a folder and an experiment containing basic 
analysis options.

1 Click the corresponding buttons on the Workspace toolbar to display the 
Browser ( ), Cytometer ( ), Inspector ( ), Worksheet ( ), and 
Acquisition Dashboard ( ) windows, as needed.

NOTE As you work in the software, windows can become hidden. Bring a 
window to the forefront by clicking the corresponding button on the 
Workspace toolbar.

2 Select Edit > User Preferences and select the options in the General tab that 
are appropriate for your experiment.

NOTE The options Tube-specific worksheet and Save analysis after 
recording through global worksheet do not apply to plate runs on the HTS.

3 Click the New Folder button ( ) on the Browser toolbar.

4 Rename the folder Practice.

To rename any Browser object, select it in the Browser and start typing. 
Press Enter to apply the new name.

5 With the Practice folder selected, click the New Experiment button ( ) on 
the Browser toolbar.

A new, open experiment is added below the Practice folder in the Browser. 
The experiment contains default cytometer settings and a global worksheet 
in a Global Worksheets folder.

6 Rename the experiment.

For example, use today’s date.
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7 If necessary, click the Inspector button ( ) on the Workspace toolbar to 
show the Experiment Inspector. Verify that the Use global cytometer 
settings checkbox is selected (see Figure 3-1).

Figure 3-1  Experiment Inspector

8 Click the arrow next to the New Plate button ( ) on the Browser 
toolbar and select a plate from the list.

The list contains plates that have been validated with the HTS. For details 
on each plate type, see Table 3-1 on page 74. 

NOTE The HTS is compatible only with standard-depth 96- or 384-well 
plates.  

Table 3-1  Plates compatible with the HTS

 Plate Type Well Capacity (µL) BD Catalog No.

384 flat-bottom 120 353233

96 flat-bottom 300 353915

96 U-bottom 300 353910

96 V-bottom 340 353263
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The selected plate type is added to the experiment.

9 If necessary, click the Plate button ( ) on the Workspace toolbar to view 
the Plate window.

Setting Up the Plate

In this section, you will add setup controls, compensation controls, and samples 
to the plate to run a 6-color experiment. As an example, you will be recording 
and analyzing human peripheral blood stained with the following reagents: 
CD14 FITC/CD16+CD56 PE/CD 8 PerCP-Cy™5.5/CD19 PE-Cy™7/CD3 APC/
CD4 APC-Cy7. You will need seven compensation control wells to accommodate 
the unstained control and the six fluorochromes you are using in your 
experiment. For information about setting up the plate, see Setting Up for Plate-
Based Acquisition on page 28.

1 If necessary, click the Inspector button on the Workspace toolbar to view 
the Plate Inspector. Select a Throughput Mode of Standard.

Make sure you select the plate type that corresponds to the plate you are 
using. BD FACSDiva software cannot verify that the chosen plate matches 
the plate on the HTS. If you select the wrong plate, the probe could hit the 
plate between wells or strike the bottom of a well, resulting in damage to 
the cytometer.

Workspace toolbar

Plate button
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Alternatively, select the throughput mode in the upper-right corner of the 
Plate window’s Setup view.

NOTE Setup and compensation control wells are always acquired in 
standard mode, even if high-throughput mode is selected in the Plate 
Inspector. Sample wells are acquired using the throughput mode selected in 
the Plate Inspector unless you acquire individual wells manually (in which 
case high-throughput mode is not an option). See Running Wells Manually 
on page 61 for more information.

2 In the Browser, click the Experiment (global) Cytometer Settings.

3 Delete any unnecessary parameters in the Parameters tab of the Cytometer 
Inspector.
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The parameters should match those shown in the following figure.

4 Click and drag to select wells A1 and A2 in the plate layout.

5 Click the Add Setup Controls button ( ) on the Plate toolbar to add 
setup control wells to the experiment.

These two wells will be used for unstained controls to set the threshold and 
PMTs.

NOTE Designate at least two wells as setup controls to make sure that you 
do not run out of sample while optimizing cytometer settings.

6 Select well B1, then select Experiment > Compensation Setup > Create 
Compensation Controls.

7 Verify that the options in Figure 3-2 on page 78 are selected.
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Figure 3-2  Create Compensation Controls dialog

8 Click OK.

The specified compensation controls are added to wells B1–B7.

9 Click and drag to select the following wells, then click the Add Specimen 
Wells button ( ) to add two specimens to the plate layout.

NOTE You can change the specimen name using the Specimen Inspector.

Wells Name

C1–C12 Specimen_001

D1–D12 Specimen_002

Include
unstained

control
checkbox

Plate button
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The plate layout should look similar to Figure 3-3.

Figure 3-3  Setup view

10 Select Experiment > Experiment Layout, then click the Labels tab 
(Figure 3-4 on page 81).

11 Define the fluorophore labels for both specimens.

Fluorophore Label

APC CD3

APC-Cy7 CD4
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a Select the FITC column of Specimen_001 and Specimen_002.

b Click in the Label field and enter CD14.

The selected fields are labeled CD14.

c Label the remaining fluorophores.

NOTE There are other fast ways to create labels. See the BD FACSDiva 
Software Reference Manual.

The Experiment Layout should look similar to Figure 3-4.

PerCP-Cy5.5 CD8

FITC CD14

PE CD16+CD56

PE-Cy7 CD19

Fluorophore Label
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Figure 3-4  Labeled fluorophores in the Experiment Layout

12 Click the Acquisition tab in the Experiment Layout (Figure 3-5), and set 
the number of events to record.

NOTE Setup controls are acquired, but not recorded. We recommend that 
you set the aspirated volume for the setup controls high enough so you can 
optimize settings before you reach the BD FACSDiva stopping time.

Name Events to Record

Compensation controls 10,000

Specimens 10,000
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NOTE Press Ctrl+Shift+End to set multiple fields at one time, and then 
type in the number of events in one of the fields. All selected fields will 
reflect the new number of events.

NOTE Another way to add a value to the Events to Record field using the 
list is to select the field you want to change, then double-click the item in 
the list to apply it to the field. 

See the BD FACSDiva Software Reference Manual for more ways to add 
events.

Figure 3-5  Acquisition tab of the Experiment Layout

13 Click OK to save the changes. 
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Setting Up the Worksheet

This section describes how to set up plots in a global worksheet.

1 Create an FSC vs SSC plot on the global worksheet.

The plot parameters should be FSC-A and SSC-A.

2 Create a PE histogram next to the FSC vs SSC dot plot and change the plot 
parameter to PE-A.

3 Create the following dot plots, choosing the appropriate parameters:

• FITC vs PE

• PerCP-Cy5.5 vs PE-Cy7

• APC vs APC-Cy7

4 Show a population hierarchy.

The worksheet should look similar to Figure 3-6 on page 84.
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Figure 3-6  Plots on a global worksheet

NOTE Alternatively, you can view the unstained normal worksheet, and 
select Edit > Select All > Copy. Then view the global worksheet, and right-
click and select Paste. Draw the gates (FSC vs SSC plot and all histograms) 
or you can copy the gates from an unstained normal worksheet. During 
acquisition, drag the gates to the populations of interest.
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5 Assign a name to the global worksheet. 

In the Browser, select the worksheet, then select Rename from the shortcut 
menu.

You are now ready to set up the cytometer for acquisition.

Exporting a Plate as a Template

After you have set up a plate, you can export it as a template. Creating a plate 
template can save you setup time if you routinely use the same sample setup. 
Plate templates include keywords, labels, cytometer settings, and HTS settings, 
but do not include recorded data.

1 Select 96 well - U bottom in the Browser, then select File > Export > Plate 
Template.

Alternatively, in the Browser, select the plate to be exported. Then select 
Export > Plate Template in the shortcut menu.

The Export Plate Template Wizard opens. The bold text at the top of the 
dialog tells you what to do on each screen. See Figure 3-7 on page 86.
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Figure 3-7  Export Plate Template Wizard

2 Select the global worksheet to include in the template.

3 Click Next.

4 Select the template type and enter a name.

The template type is used to group similar templates so they are easy to 
find. At a minimum, you need to enter only the type and name when you 
are exporting a plate template. The remaining screens are optional.

NOTE Select the Lock Template checkbox when you want to prevent other 
users from overwriting your template.

5 Click Next, then click Finish.

Assigning Keywords

Keywords are used to enter information about the wells, such as sample type and 
preparation details. For more information, see the BD FACSDiva Software 
Reference Manual.
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Preparing for Acquisition

This section describes how to optimize cytometer settings and to perform 
compensation.

Optimizing Cytometer and HTS Settings

The default settings provide a good starting point for achieving optimal 
throughput in either mode, but they should be optimized for your plate type and 
sample volume.

1 Click the Setup tab of the Plate window.

2 Click each setup control well, view the Cytometer Settings, and verify that 
they are the same as defined in Setting Up the Plate on page 75.

3 Remove the safety cover on the HTS and place the prepared plate on the 
plate holder. 

Make sure the plate corresponds to the type selected in the software. Orient 
the plate with well A1 at the back-right corner of the stage. See Figure 3-8 
on page 88.

To prevent damage to the HTS probe, always remove the multiwell plate 
cover before you put the plate on the holder.
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Figure 3-8  Orienting the plate (BD FACSCanto example)

4 Replace the HTS safety cover. 

5 (BD LSR II and BD LSRFortessa) Press the RUN button on the cytometer. 

6 Select the two setup control wells in the plate layout of the Setup view. 

The well is outlined in green .

7 Click Run Well(s) in the Acquisition Dashboard.

If necessary, select View > Acquisition Dashboard.

The HTS homes and primes the probe, and then aspirates the unstained 
control from the first setup control well.

Do not put the BD LSR II in Standby during HTS acquisition. 
BD FACSDiva software cannot continue the run when the cytometer is in 
Standby, and it can cause damage to the flow cell.

Front of HTS

Well A1
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NOTE Setup and compensation wells are always acquired in standard 
mode, even if high-throughput mode is selected in the Plate window.

8 If needed, adjust the FSC, SSC, threshold, and PMTs using the unstained 
control.

For more information on optimizing cytometer settings, see the appropriate 
cytometer user’s guide.

NOTE Acquisition stopping time is determined by BD FACSDiva software, 
according to sample volume/sample rate. If you run out of sample before 
you finish optimizing settings, allow the HTS to move to the next setup 
control well and continue optimization from there. 

9 Click Stop Well(s) once you have optimized settings.

The HTS goes through a purge cycle.

NOTE No data file is saved for setup control wells.

Performing Compensation

Once you have optimized the cytometer settings, you are ready to run the 
compensation controls and calculate compensation.

NOTE You can run compensation controls only once during an experiment. If 
you need to re-run compensation controls, you must create a new experiment.

1 Select wells B1 through B7 in the plate layout.

2 Click Run Well(s) in the Acquisition Dashboard.

The compensation wells are run in the order they were created. 

Verify that no other software applications are running before you start 
acquisition. BD FACSDiva software performance time can be severely 
affected if multiple applications are running at the same time.
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NOTE You must select a well(s) in the Setup view, and a global worksheet 
must be in view, to enable the Run Well(s) button.

After the last compensation control has been recorded, the Sequence Done 
dialog opens.

3 Click OK.

4 Toggle to the normal worksheet for the compensation control wells. 

5 Select the FITC Stained Control worksheet in the Worksheet window.

6 Verify that the P1 gate encompasses the singlet bead population.

7 Verify that the autointerval gate encompasses the positive peak in each of 
the plots on all worksheets.

8 Select Cytometer > Cytometer Setup > Calculate Compensation.

If the calculation is successful, a dialog opens.

9 Name the compensation setup after the experiment, then click OK.

For information on performing compensation, see the BD FACSDiva 
Software Reference Manual.

NOTE Compensation controls can be run individually through their normal 
worksheets using the Basic Controls in the Acquisition Dashboard.
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Acquiring Data

Once you have calculated compensation, you are ready to record your samples.

1 Click the Worksheets View button to return to the global worksheet.

2 Select well C1 in the plate layout.

3 Click Run Plate in the Acquisition Dashboard.

Wells are acquired in the order they were created.

As each well is injected into the cytometer SIT, events appear in plots on the 
global worksheet. If an error occurs, an error message appears, and the well 
in the plate layout is colored according to its status. Well status is indicated 
by the color outlining each well, as described in Plate Layout on page 48.

At the end of the run, a dialog opens indicating that the run is complete.

4 Click OK to close the completion dialog.

5 Open the safety cover and remove the plate.

NOTE Access the plate only after sample processing is complete and the 
probe is no longer moving.

The HTS is equipped with a safety interlock that prevents the cytometer 
from running when the safety cover is removed or opened. Do not remove 
or open the safety cover while samples are being processed. To pause or 
stop acquisition, click the corresponding buttons on the Acquisition 
Dashboard before you remove or open the safety cover. 
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6 Click the Print button on the Plate toolbar to print a record of the Setup 
view and legend.

7 Select the appropriate settings and printer, then click OK.

Use the printout to:

• View the acquisition run order according to well numbering.

• Determine the well status after acquisition. (See Plate Layout on 
page 48.)

8 At the end of each day or shift, clean and service the cytometer as described 
in Daily Maintenance on page 112.

Pausing the HTS

To pause a run, click Pause in the Acquisition Dashboard. The HTS finishes 
processing the current well (or wells in high-throughput mode), and then remains 
in a suspended state until you choose to continue. 

• To continue the run, click Resume. 

• To stop the run, click Stop Well(s) or Stop Plate. 

This sequence allows you to stop the run early to minimize sample loss.

Keep a record of the acquisition status by printing a copy of the Setup view 
immediately after acquisition is complete. Refer to the printout if you 
reanalyze or export the data. If you export a data file or an experiment that 
contains incomplete data, the software cannot recognize that the file is 
incomplete.
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Stopping the HTS

The HTS stops automatically when plate acquisition is finished. Do the following 
if you need to stop the HTS in the middle of a run. 

1 Click Stop Plate or Stop Well(s) in the Acquisition Dashboard.

The HTS finishes the sequence in progress, stops, and then the Sequence 
Done dialog opens.

NOTE If you are using the Basic Controls to acquire, simply click Stop 
Acquiring.

2 Click OK.

Exporting an Experiment as a Template

Now that you have completed an experiment with cytometer and HTS settings, 
you can export it as a template. Creating analysis templates for assays that you 
typically run saves setup time. Experiment templates include plates, keywords, 
labels, worksheet elements and worksheets (including all settings such as page 
breaks), cytometer settings, and HTS settings, but do not include recorded data.

1 Select Experiment_001 (or whatever you named it) in the Browser.

2 Select File > Export > Experiment Template.

Alternatively, from the shortcut menu, select Export > Experiment 
Template.

NOTE Make sure you select the Experiment Template command, and not 
the Experiments command.

If you stop the HTS during a run in standard mode, the current well will be 
lost. If you stop the HTS in high throughput mode, the current and next 
well will be lost. Do not stop acquisition if your sample volume is limited.
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The Export Experiment Template Wizard opens. The bold text at the top of 
the dialog tells you what to do at each screen.

3 Enter Practice for the template type, and 6-Color Analysis for the template 
name.

The template type is used to group similar templates so they are easy to 
find. At a minimum, you need to enter only the type and name when you 
are creating a template. The remaining screens are optional.

NOTE Select the Lock Template checkbox when you want to prevent other 
users from overwriting your template with the same name.

4 Click Next, Next, and then Finish.

NOTE To export a Panel template, select a specimen in the Plate window 
and follow steps 1 to 4.
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Analyzing Data

This section describes how to use the analysis view and the batch analysis feature 
in BD FACSDiva software to analyze data from plate-based acquisition.

Displaying Keywords

1 Click the Analysis tab to display the Analysis view.

The Analysis view shows the acquisition status of each well.

2 Click the Add Keywords button ( ) on the Plate toolbar.

The Add Keywords dialog opens. See Figure 3-9 on page 96.
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Figure 3-9  Add Keywords dialog

3 Alt+Shift+Click the keywords Concentration, Lymphocytes, and 
Granulocytes from the Available Keywords list (on the left side of the 
dialog). The Concentration, Lymphocytes, and Granulocytes keywords 
were created for this example.

4 Click Add to move the keywords to the Selected Keywords column, then 
click OK.

The three keywords now appear in the Keywords list in the Analysis view.

5 Click the keyword Concentration in the Keywords list.

The Analysis view changes to the Keyword view (Figure 3-10 on page 97). 
If values were assigned to the selected keyword, the values are displayed in 
this view.

In this example, the selected keyword is Concentration and the values are 
0.10, 0.25, 0.50, and 0.75.
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Figure 3-10  Keyword Analysis view showing concentration values

6 Click the Print button ( ) on the Plate toolbar to print the concentration 
keyword view and legend.

7 Select the appropriate print options, then click OK.

Save the printout for your records.

8 Click the keyword Lymphocytes in the Keywords list.

The Keyword view displays the values for the keyword Lymphocytes. See 
Figure 3-11 on page 98.
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Figure 3-11  Keyword Analysis view showing lymphocytes values

9 Print the Lymphocytes Keyword view and legend.

10 Click the keyword Granulocytes in the Keywords list.

The wells that were designated with the keyword Granulocytes are colored 
yellow-green, but do not list a value since none was assigned.
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Figure 3-12  Keyword Analysis view showing granulocytes wells

11 Print the Granulocytes Keyword view and legend.

Performing Data Analysis

Analyze plate data in the same manner you would analyze tube data using 
BD FACSDiva software. For detailed instructions, see the BD FACSDiva 
Software Reference Manual.

Performing Batch Analysis

Do the following to set up batch analysis:

1 Open an experiment containing the plate data that you want to analyze.

2 Double-click the plate in the Browser to open the Plate window.
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3 Click the Analysis tab to display the Analysis view.

4 In the global worksheet, verify that the gates enclose the appropriate 
populations.

5 In the plate layout, select the wells for batch analysis, right-click to open 
the shortcut menu, and then select Batch Analysis.

NOTE If you wish to print, you must assign a printer before starting batch 
analysis.
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The Batch Analysis dialog opens.

6 Select the type of analysis to be done.

• Select Auto to analyze all files with no user intervention. Data is 
displayed in the global worksheet for the amount of time specified in 
the View Time field (in seconds) before analysis of the next well begins. 
Make adjustments to your analysis during this pause or let analysis 
proceed automatically. Select zero only if you want to process the batch 
without reviewing the data between wells.

• Select Manual to pause the batch after data is loaded for each well. 
Click the Continue button to proceed with analysis of the next well. 
The View Time field is disabled when you select Manual analysis.

• You can print worksheets or export statistics before data for the next 
well is loaded.

Output to Printer. Print a copy of the analysis for each well.

Statistics. Export statistics to a single comma separated value (CSV) file 
for the batch. The resulting file can be opened with a spreadsheet 
application such as Microsoft Excel®. Depending on the auto-export 
format selected in User Preferences, each well adds a new row or 
column of results to the file. For each population in the statistics view, 
the software adds parameter statistics in the order in which they appear 
in the view. A new header row is added if you add or delete statistics or 
parameters during batch analysis. You cannot add, remove, or edit 
statistics views while the batch is running.
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• Save as PDF. The Add Report to PDF and View PDF checkboxes 
become active. If Add Report to PDF is selected, the Batch Analysis 
Report is added to the top of the worksheet’s PDF file. If View PDF is 
selected, the PDF is automatically displayed at the completion of the 
batch analysis.

• Specify whether to let biexponential scales fluctuate, if applicable. 
When the Freeze Biexponential Scales checkbox is selected, 
biexponential scaling does not change during batch analysis. All data is 
processed using scales from the tube where the current tube pointer is 
set. For information on biexponential scales, see the BD FACSDiva 
Software Reference Manual.

Preferred global worksheets can be used with wells and specimens. For 
information on using preferred global worksheets, see the BD FACSDiva 
Software Reference Manual.

7 Click Start to begin batch analysis.

A dialog informs you when batch analysis is complete.

NOTE A plate GUID (globally unique identifier) appears in the statistics view. 
This number is unique for each plate.

Maintaining Data

Maintain the database by keeping the size below recommended limits, backing 
up data on a regular basis, and deleting experiments and plates that you no 
longer need. Follow the precautions and instructions for database management 
given in the BD FACSDiva Software Reference Manual.
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Setting Up for Tube-Based Acquisition

This section describes how to change from plate-based acquisition to tube-based 
acquisition.

Setting Up for Tube-Based Acquisition (BD LSR II 
and BD LSRFortessa)

To switch from plate mode to tube mode:

1 Perform the daily clean procedure. See Daily Cleaning on page 112.

2 Place the cytometer in Standby mode.

3 Switch off the HTS power.

4 Detach the sample coupler from the cytometer SIT by unscrewing the top 
thumbscrew. Once the coupler feels free, gently pull it straight down from 
the SIT. 

5 Remove the SIT protector.

Unscrew the tube retainer and slide the SIT protector straight down.

Any cytometer surface that comes in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when handling 
cytometer hardware. Wear suitable protective clothing, eyewear, and 
gloves. 

To avoid bending the SIT, pull straight down on the coupler. Do not pull the 
coupler at an angle.

To avoid bending the SIT, do not slide the SIT protector at an angle. 
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6 Reinstall the standard droplet containment module (DCM) sleeve 
(Figure 3-13 on page 104).

a Slide the sleeve straight up over the SIT.

b Screw the tube retainer on to secure it.

Figure 3-13  Installing the DCM sleeve

7 Install a tube of deionized (DI) water on the SIT and place the tube support 
arm under the tube.

8 Switch the acquisition control switch to tube mode ( ).

9 Uninstall the HTS.

a Detach the HTS from the cytometer (see Removing the HTS on 
page 166 and Figure 3-14 on page 105).

b Remove the base plate by loosening the thumbscrews at the bottom of 
the cytometer support bracket (see step 13 on page 142). 

Tube retainer

DCM sleeve
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NOTE If you are not going to use the HTS for a week or longer, follow the 
instructions under Placing the HTS in Long-Term Storage on page 140. 

Figure 3-14  BD High Throughput Sampler detached from cytometer

10 If applicable, perform the monthly cleaning as outlined in Monthly 
Cleaning on page 119, install a new sheath filter, and fill the sheath tank 
with BD FACSFlow™ sheath fluid.

To prevent personal injury or damage to the HTS, disconnect the HTS from 
the cytometer and remove the HTS before running tube-based acquisition.

Thumbscrew Thumbscrew

Base plate

Cytometer 
support 
bracket
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Exchanging the Sheath Fluid (BD LSR II and BD LSRFortessa)

Follow the instructions under Monthly Cleaning (BD LSR II and 
BD LSRFortessa) on page 119. In step 16, replace the sheath filter with a new 
filter instead of reconnecting the old filter.

NOTE If you exchanged BD FACSFlow with BD FACS sheath solution with 
surfactant, install the HTS sample coupler, then prime the system twice by 
selecting HTS > Prime. This exchanges the fluid in the syringes with BD FACS 
sheath solution with surfactant.

Setting Up for Tube-Based Acquisition 
(BD FACSCanto and BD FACSCanto II)

Before running BD FACSCanto clinical software, you must exchange BD FACS 
sheath solution with surfactant with BD FACSFlow sheath fluid. Version 2.4 of 
the clinical software cannot connect in acquisition mode if the sheath type is set 
to BD FACS sheath solution with surfactant.

1 Perform a sheath exchange to replace BD FACS sheath solution with 
surfactant with BD FACSFlow sheath fluid. 

See Exchanging the Sheath Fluid (BD FACSCanto and BD FACSCanto II) 
on page 107.

2 Detach the sample coupler from the cytometer SIT by unscrewing the top 
thumbscrew. Once the coupler feels free, gently pull it straight down from 
the SIT.

NOTE For the BD FACSCanto, place the sample coupler in the clamp on 
the catch tray when the coupler is not in use (see Figure B-12 on page 183).

To avoid bending the SIT, pull straight down on the coupler. Do not pull the 
coupler at an angle.
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Exchanging the Sheath Fluid (BD FACSCanto and 
BD FACSCanto II)

Perform this procedure to exchange one sheath fluid with another. For example, 
when switching from plate-based to tube-based acquisition, follow these steps to 
exchange BD FACS sheath solution with surfactant with BD FACSFlow.

1 Remove the sample coupler from the SIT.

2 Install a cubitainer containing the sheath fluid you want to use.

3 Empty the waste tank, if necessary.

4 Select Cytometer > Cleaning Modes > Prime after Tank Refill to display the 
Tank Prime window.

5 Select FACSFlow, then click OK.

NOTE It may be necessary to purge air from the sheath filter on the wet 
cart, then prime two or three times. See your cytometer user’s guide for 
more information on troubleshooting air in the fluid lines.
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6 Select Cytometer > Sheath Exchange, and select the desired sheath 
exchange.

A confirmation dialog opens.

7 Click OK.

8 Click OK in the next dialog to confirm the duration.

A dialog opens informing you that the sheath exchange is complete.

9 Click OK.

NOTE When the sheath type is BD FACSFlow, the sheath fluidics level indicator 
( ) is green. When the sheath type is BD FACS sheath solution with surfactant, 
the level indicator is white.

NOTE If you exchanged BD FACSFlow with BD FACS sheath solution with 
surfactant, install the HTS sample coupler, then prime the HTS twice by selecting 
HTS > Prime. This exchanges the fluid in the syringes with BD FACS sheath 
solution with surfactant.
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Shutting Down

Perform the daily cleaning procedure before shutting down the system. 

1 Run the daily cleaning procedure (see Daily Cleaning on page 112).

2 (BD FACSCanto and BD FACSCanto II) Perform a fluidics shutdown. See 
Fluidics Shutdown in the following section.

3 (BD LSR II and BD LSRFortessa) Prime the HTS. 

a Place the cytometer in Run mode.

b Select HTS > Prime. 

c When priming is complete, click OK in the dialog, then place the 
cytometer in Standby mode.

NOTE To prime the cytometer, press the Prime button on the fluid control 
panel on the cytometer itself.

4 (BD FACSCanto, BD LSR II, and BD LSRFortessa) Turn off the power to 
the HTS. 

5 Turn off the power to the cytometer.

6 Quit the software (see Quitting the Software on page 110).
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Fluidics Shutdown

(BD FACSCanto and BD FACSCanto II) Perform a fluidics shutdown before 
quitting the software. 

1 Ensure that the sample coupler is attached.

NOTE Always run the fluidics shutdown with the sample coupler attached 
to rinse the syringes and fill them with BD FACS shutdown solution. 

2 Select Cytometer > Fluidics Shutdown.

A confirmation dialog opens.

3 Click OK.

A dialog opens when fluidics shutdown is complete.

4 Click OK.

Quitting the Software

If you have a BD FACSCanto or BD FACSCanto II, you must perform a fluidics 
shutdown by selecting File > Quit before quitting the software (see Fluidics 
Shutdown on page 110). All Browser and worksheet elements are automatically 
saved when you quit the application.
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4

Maintenance

This chapter provides maintenance procedures to keep your HTS in good 
working order. 

NOTE You can also use the BD Biosciences HTS Customer Care Kit to replace 
clogged connectors, tubing, and syringes on your HTS. Using the HTS Customer 
Care Kit reduces downtime and the need for depot repair (see Depot Repair 
Procedures on page 165). For detailed information about using the HTS 
Customer Care Kit to prevent clogs and optimize system performance, see the 
HTS Customer Care Kits User’s Guide.

The following maintenance procedures are covered in this chapter.

• Daily Maintenance on page 112

• Monthly Maintenance on page 119

• Periodic Maintenance on page 122

• Unscheduled Maintenance on page 144
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Daily Maintenance

When running the HTS daily, perform the following at the end of every day (or 
shift):

• Daily Cleaning on this page

• Cytometer Inspection and Servicing on page 116

NOTE (BD LSR II and BD LSRFortessa) When running samples containing 
acridine orange or propidium iodide (or any nucleic dyes), run the daily clean 
twice. First, run 70% isopropyl alcohol in wells A1–A4 and BD™ FACSClean or 
a 10% bleach solution in wells B1–B4. Second, run BD™ FACSRinse solution in 
wells A1–A4, followed by DI water in wells B1–B4.

Daily Cleaning

During the daily clean procedure, the cytometer samples cleaning solution and 
then DI water from predefined wells and performs a sequence of mixing, 
aspiration, and rinsing. Software prompts guide you through the cleaning 
sequence. Perform the cleaning procedure at the end of every day or shift while 
the cytometer is in plate-based mode. Allow 15 minutes to complete this 
procedure.

Materials Needed

• BD FACSClean or a fresh 10% bleach solution (1 part bleach in 9 parts DI 
water)

• BD FACSRinse solution

• DI water
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Running the Daily Clean

1 Select HTS > Clean.

The Plate Templates dialog opens(Figure 4-1 on page 113).

Figure 4-1  Plate Templates dialog

2 Select the Daily Clean - 96 well U-bottom template, if not already selected.

If you do not have a U-bottom plate for cleaning, you can set up your own 
cleaning template.

3 Click OK.

• The plate interface changes to show the Daily Clean Protocol view 
(Figure 4-2 on page 114) and the confirmation dialog opens.
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Figure 4-2  Daily Clean Protocol view

Figure 4-3  Cleaning confirmation dialog

NOTE Do not click OK at this time.

4 Fill the wells of a 96-well plate according to the following table. 

Wells Solution Volume (µL)

A1–A4 BD FACSClean (or a 
10% bleach solution)

200

B1–B4 DI water 200
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NOTE If you wish to run BD FACSRinse solution as part of the daily 
cleaning procedure, repeat the daily clean using BD FACSRinse solution in 
wells A1–A4 and DI water in wells B1–B4.

5 Remove or open the safety cover and place the plate on the plate holder.

Make sure the plate corresponds to the type selected in the software. Orient 
the plate with well A1 on the back-right corner of the stage. See Figure 4-4 
on page 115. Verify that the sample coupler is properly installed and is not 
leaking.

Figure 4-4  Orienting the plate

6 Replace the safety cover.

7 (BD LSR II and BD LSRFortessa) Place the cytometer in Run mode. 

8 Verify that the Cytometer window displays Cytometer Connected.

9 Select well A1 (the first well for the cleaning protocol).

To ensure that the 10% bleach solution retains its full germicidal effect, 
prepare a fresh solution daily.
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10 Click OK to close the Cleaning Confirmation dialog (Figure 4-3 on 
page 114).

The cytometer goes through a homing sequence, and cleaning begins. Note 
that the cleaning procedure can take up to 15 minutes.

11 Click OK when the completion dialog opens.

12 Remove and discard the multiwell plate, or rinse it for use on another day.

Cytometer Inspection and Servicing

Inspect the following cytometer components at the end of each day and service 
them, as needed.

• Sample coupler 

Check for leaks around the sample coupler on the cytometer SIT. If 
necessary, tighten the top nut to secure the sample coupler to the SIT.

All cytometer surfaces that come in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when handling 
cytometer components. Wear suitable protective clothing, eyewear, and 
gloves. 
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If the coupler continues to leak after you tighten the fitting, remove and 
then reinstall the coupler as follows.

a Hold the coupler with one hand while you unscrew the tightening nut 
with the other hand.

b When the coupler is loose, pull it straight down.

c Slide the coupler back up until you reach a hard stop. Make sure the 
sample coupler tubing is not kinked or twisted.

d Hold the coupler with one hand while you tighten the tightening nut 
with the other hand.

If the coupler is still leaking, replace it. See Replacing the Sample Coupler 
and Tubing on page 130.

• Injection port/wash station

Check this area for residual liquid. Liquid appearing around the injection 
port/wash station may indicate a clog. If you suspect a clog, see HTS 
Troubleshooting on page 154.

• Base plate, probe arm assembly, and plate holder

BD LSR II/BD LSRFortessa BD FACSCanto/BD FACSCanto II

Tightening nut



118 BD High Throughput Sampler User’s Guide   

Dampen a clean, lint-free cloth with distilled or DI water and wipe down 
only the black surfaces of these components, as needed.

• Sample probe

Make sure the probe is straight. If it is bent or shows signs of wear, replace 
the probe. See Replacing the Probe on page 136.

• Pumps

- Wipe up any spills on or around the pumps.

- Inspect the fittings to make sure they are tight. See Inspecting the 
Thumbscrew Fittings on page 149 and Inspecting the Hexagonal Fittings 
on page 150. 

- Inspect the pump syringes for leakage. If your system has been used 
extensively and the syringes appear worn, replace them. See Replacing 
a Pump Syringe on page 132.

• (BD LSR II, BD LSRFortessa, and BD FACSCanto) Absorbent pad

Inspect the absorbent pad at the back of the HTS to make sure it is not 
saturated. Replace the pad, if needed.
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Monthly Maintenance

When running the HTS daily, perform the following cleaning procedures at the 
end of every month. If you are using the HTS less frequently, adjust the monthly 
maintenance schedule accordingly.

• Monthly Cleaning on page 119

• Surface Inspection and Cleaning on page 121

Monthly Cleaning

Monthly Cleaning (BD LSR II and BD LSRFortessa)

To perform the monthly clean you will need DI water and BD FACSClean or a 
fresh 10% bleach solution (1 part bleach in 9 parts DI water).

1 Bypass the cytometer sheath filter.

a Press the quick-disconnectors on both sides of the filter assembly.

b Remove the filter assembly.

c Reconnect the two fluidic lines.

2 Remove the sheath line filter on the supply line from the cytometer to the 
HTS. See Sheath line and filter (example shown for BD LSR II) on 
page 127.

3 Remove the sheath tank and replace the sheath fluid with BD FACSClean 
solution or a freshly prepared 10% bleach solution. Replace the tank. 

To ensure that the 10% bleach solution retains its full germicidal effect, 
prepare a fresh solution daily.
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4 Open the roller clamp on the sheath line that enters the side of the 
cytometer, for approximately 10 seconds, to remove excess air from the 
sheath line.

5 Close the roller clamp.

6 Prime the cytometer two to three times to bring the cleaning fluid to the 
flow cell.

7 Place the cytometer in Run mode.

8 Select HTS > Prime and repeat the prime.

9 Select HTS > Monthly Cleaning.

The Monthly Clean dialog opens.

10 Click Continue.

A dialog appears while cleaning is in progress. This can take up to 
30 minutes.

11 When prompted, remove the tank and replace the cleaning solution with DI 
water.

12 Reinstall the tank. 

A progress dialog appears while rinsing is in progress. This can take up to 
30 minutes.

13 Click Continue.

14 Click OK when monthly cleaning is complete.
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NOTE If you have been running BD FACSRinse solution as part of a 
biweekly cleaning procedure, you can repeat the monthly cleaning using 
BD FACSRinse solution followed by DI water.

15 Disconnect the tank, fill it with sheath solution, and reconnect it.

16 Reconnect the cytometer sheath filter from step 1.

NOTE If you are performing a sheath fluid exchange, install a new filter.

17 Reconnect the HTS sheath line filter from step 2.

18 Check for bubbles and prime, if necessary.

Monthly Cleaning (BD FACSCanto and BD FACSCanto II)

1 Ensure that the sample coupler is properly installed and the HTS is 
powered on. 

2 Empty the waste tank, if necessary.

3 Ensure that the BD FACSClean and BD FACS shutdown solution 
cubitainers are full and connected.

4 Select Cytometer > Long Clean.

5 Click OK when the long clean is complete.

Surface Inspection and Cleaning

• Use BD FACSClean solution (or a 10% bleach solution) followed by DI 
water to wipe down the HTS enclosure and cover on a monthly basis, or 
when needed. 

All cytometer surfaces that come in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when handling 
cytometer surfaces. Wear suitable protective clothing, eyewear, and gloves. 
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• Inspect the pump syringes for leaks and tighten fittings, if required. See 
Inspecting the Thumbscrew Fittings on page 149.

Periodic Maintenance

To ensure optimal performance of your HTS system, replace the following 
cytometer components according to the recommended replacement schedule in 
Table 4-1. Note that the extent of maintenance will vary depending on how much 
you use your system. Use the schedule in Table 4-1 as a guideline.

A maintenance log is provided in Appendix A to keep track of when each 
procedure is performed.

Table 4-1  Recommended replacement schedule

Component Part No. Replacement Schedule Procedure

Sample injection tubinga

a. See Figure 4-5 on page 123.

335526 (A)

335451 (F)

Every 6 months page 123

Sheath filter 335710 Every 6 months page 126

Air filter 336218 Yearly or as needed page 128

Sampler coupler and 
tubing (BD LSR II and 
BD LSRFortessa)

335452 Yearly or as needed page 130

Sampler coupler and 
tubing (BD FACSCanto 
and BD FACSCanto II)

339340 Yearly or as needed page 130

Syringes 339047 Yearly or as needed page 132

Probe 34389017 Yearly or as needed page 136

Quick-connector O-ring 343618 Yearly or as needed page 137

SIT protector and O-ring 
(BD LSR II and 
BD LSRFortessa)

335345 Yearly or as needed page 138
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Replacing the Sample Injection Tubing

The sample injection tubing connects the injection port/wash station to the 
secondary pump valve tubing. Replace the tubing every 6 months.

Figure 4-5  Disconnecting sample injection tubing from injection port/wash station

1 Perform the monthly clean procedure to decontaminate the sample 
injection port/wash station.

See Monthly Cleaning on page 119. 

2 Turn off the HTS power switch (BD FACSCanto, BD LSR II, and 
BD LSRFortessa), or turn off the cytometer (BD FACSCanto II).

3 For easy access, remove the HTS.

Number Description

1 Sample injection tubing

2 Hex screw

3 Sample injection port/wash station

4 Thumbscrew

5 Thumbscrew

6 Secondary pump valve tubing

7 Connector

All cytometer surfaces that come in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when changing 
tubing. Wear suitable protective clothing, eyewear, and gloves. 

1

2 5 4

36

7
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See Removing the HTS on page 166 for instructions. 

4 Move the probe arm up, then push it toward the front of the HTS.

5 Remove the sample injection tubing (A) from the HTS. See Figure 4-7 on 
page 124.

a If necessary, disconnect the top hex screw (B) from the secondary pump 
using the 5/16-in wrench in the accessory kit (Figure 4-5 on page 123 
and Figure 4-6).

Figure 4-6  Hex screw on secondary pump

b Turn the sample injection port/wash station (C) slightly to disengage 
the magnetic force, then lift it up to expose the thumbscrew (D) on the 
sample injection tubing (A) and the thumbscrew (E) on the secondary 
pump valve tubing (F) (Figure 4-7).

Figure 4-7  Accessing the tubing

Hex screw (B)

Secondary pump

Secondary pump
valve tubing (F)

Sample injection port/ 
wash station (C)

Sample injection tubing (A)

Thumbscrew (E)

Thumbscrew (D)

Connector (G)
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c Unscrew the thumbscrew (E) from connector (G) and remove the 
secondary pump valve tubing (F) (Figure 4-5 on page 123 and 
Figure 4-7).

d Disconnect the sample injection tubing (A) from the sample injection 
port/wash station (C) by unscrewing the thumbscrew (D) (Figure 4-7) 
and remove the sample injection tubing (A).

6 Discard the sample injection tubing (A) and the secondary pump valve 
tubing (F) as biohazardous waste.

7 Install new sample injection tubing.

Replacement tubing is included in the accessory kit.

a Screw the thumbscrew (D) onto the sample injection port/wash station 
(C).

b Screw the thumbscrew (E) from the secondary pump valve tubing into 
connector (G).

NOTE Take care to screw the thumbscrews on straight. If you attach them 
at an angle, you could strip the threads.

8 Insert the secondary pump valve tubing (F) into the opening of the HTS 
base and route the tubing to the secondary pump. Then, lower the sample 
injection port/wash station (C) onto the HTS base plate.

The magnetic force will secure the sample injection port/wash station in 
place.

9 Reconnect the secondary pump valve tubing (F) to the secondary pump by 
tightening the hex screw (B).

10 Reinstall the HTS.

Follow the instructions for Installing the HTS on page 179.
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Replacing the HTS Sheath Filter

The HTS sheath filter is integrated in the fluid line that supplies sheath fluid to 
the HTS (Figure 4-9 on page 127). Replace the filter every 6 months.

1 Loosen the positioning screw holding the HTS to the cytometer support 
bracket (Figure 4-8).

Figure 4-8  Loosening the positioning screw (example shown for BD LSR II)

2 Slide the HTS towards you by doing the following:

a Slightly lift the HTS to clear the screw.

b Being careful not to strain the sheath tubing, slide the HTS towards 
you until you can access the filter.

All cytometer surfaces that come in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when handling 
cytometer components. Wear suitable protective clothing, eyewear, and 
gloves. 

Positioning screw
Support bracket
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Figure 4-9  Sheath line and filter (example shown for BD LSR II)

3 (BD FACSCanto) Remove the catch tray.

Pull the HTS towards you slightly to allow room for removing the catch 
tray.

4 Label the sheath line connectors.

To keep track of the flow direction, label each quick-connector so you 
know which end attaches to the cytometer (C), and which end attaches to 
the HTS.

5 Remove the sheath line.

Press the metal tabs to release the two off-white quick-connectors, one on 
the cytometer interface panel and the other on the back of the HTS.

6 Remove the filter.

a Detach the filter from one tubing segment by holding the filter while 
you twist the Luer connection.

b Repeat this operation for the other tubing segment.

7 Install the new filter.

Filter

Sheath line
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a Attach the tubing segment with the male connector to the female filter 
connection. Hold the filter while you twist the Luer lock ring.

b Attach the tubing segment with the female connector to the male filter 
connection. Hold the filter while you twist the Luer female connector.

8 Reinstall the sheath line between the cytometer interface panel and the 
HTS.

Attach the quick-connectors at each end.

NOTE Although the sheath filter is a screen filter that provides identical 
performance regardless of the flow direction, we recommend that you 
always install the sheath line with the lock-ring end toward the cytometer 
panel (connector labeled C). This prevents any foreign material 
accumulated on one side of the filter from flushing into the HTS if the filter 
is reversed. 

9 Reinstall the HTS.

a (BD FACSCanto) Install the rear catch tray by routing the sample 
coupler underneath the catch tray tongue and sample coupler slot. 
Push the tray in, making sure the coupler line is not crimped or kinked. 

b Push in the HTS and tighten the positioning screw holding the HTS to 
the cytometer support bracket.

Cleaning the Air Filter

The air filter element is located within a filter retainer and fan guard attached to 
the base plate of the HTS. To clean or replace the air filter, follow these steps. 

1 Remove the HTS from the cytometer.

For detailed instructions, see Removing the HTS on page 166. 

2 Place the HTS on its side.
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NOTE To avoid scratching the finish, handle the HTS with care. Do not 
drag the HTS on the laboratory bench.

3 Remove the filter retainer.

The filter retainer is located within the air filter element in the base plate of 
the HTS.

a Place your middle and index fingers of each hand on the opposite edges 
of the filter retainer. Place your thumbs on the fan guard through the 
retainer apertures.

b Support the fan guard with your thumbs as you pull out the retainer 
with your fingers.

NOTE To prevent the HTS from tipping, use your thumbs to hold the HTS 
in place while pulling.

4 Remove the filter and clean or replace it as needed.

Filter retainer
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To clean the filter, rinse it well with water. Dry it completely before you 
reinstall it.

5 Place the clean filter inside the filter retainer.

6 Reinstall the filter retainer.

Center it over the fan guard and push evenly on the opposite edges to snap 
it into place.

7 Place the HTS right-side up.

8 Reinstall the HTS on the cytometer.

For detailed instructions, see the Installing the HTS on page 179.

Replacing the Sample Coupler and Tubing

If you frequently remove the sample coupler to run the cytometer in tube mode, 
replace the coupler yearly or if the coupler continues to leak after you have 
tightened the fitting.

1 Remove the HTS from the cytometer.

All cytometer surfaces and hardware that come in contact with biological 
specimens can transmit potentially fatal disease. Use universal precautions 
when changing tubing. Wear suitable protective clothing, eyewear, and 
gloves. 

Filter retainerFilter
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For detailed instructions, see Removing the HTS on page 166. 

2 Detach the sample coupler tubing.

Unscrew the tubing fitting from the secondary pump valve (Figure 4-10) 
and discard the sample coupler and tubing as biohazardous waste.

Figure 4-10  Detaching the sample coupler and tubing

3 Install a new sample coupler and tubing.

Replacement tubing is included in the accessory kit. Connect the new 
tubing fitting to the port in the secondary pump valve. Tighten the tubing 
fitting until it is finger-tight.

4 Reinstall the HTS on the cytometer.

For detailed instructions, see Installing the HTS on page 179.

Valves contain sealing washers in each port. If you over-tighten the fitting, 
the sealing washers can be compressed, resulting in a blocked port. Tighten 
the fitting until it contacts the sealing washer, then turn the fitting an 
additional 1/6 to 1/4 turn. If leaking is observed, tighten the fitting no more 
than an additional 1/8 turn.
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Replacing a Pump Syringe

Glass syringes are used in the primary and secondary pumps in the HTS. Replace 
the syringes once a year or whenever leaks occur or pumping accuracy is suspect. 
To begin this procedure, the cytometer and software must be running.

1 Before replacing the pump syringe, perform the monthly clean procedure.

See Monthly Cleaning on page 119.

2 (BD LSR II and BD LSRFortessa) Place the cytometer in Run mode.

3 Remove the liquid from the syringe by performing steps 1 through 11 in 
Placing the HTS in Long-Term Storage on page 140. 

4 Turn off the HTS power switch (BD FACSCanto, BD LSR II, and 
BD LSRFortessa), or turn off the cytometer (BD FACSCanto II). Keep the 
software running on the workstation.

5 If you are replacing:

• The primary pump syringe located at the front of the HTS, skip to 
step 6.

• The secondary pump syringe located at the back of the HTS, remove 
the HTS. See Removing the HTS on page 166.

All cytometer surfaces and hardware that come in contact with biological 
specimens can transmit potentially fatal disease. Use universal precautions 
when changing the syringe. Wear suitable protective clothing, eyewear, and 
gloves. 
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Figure 4-11  Primary and secondary pumps

6 Push the syringe plunger up to the top of the syringe barrel.

7 Loosen the plunger lock screw approximately three full turns 
counterclockwise (Figure 4-12 on page 134).

8 Lower the plunger drive by pushing down on the plunger lock screw.

See Figure 4-12 on page 134.

Primary syringe pump Secondary syringe pump
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Figure 4-12  Lowering the plunger

9 Unscrew the syringe from the valve.

Grasp the metal ring at the top of the syringe and turn it counterclockwise. 

10 Discard the syringe into a biohazardous sharps container.

11 Install the new syringe (Figure 4-13 on page 135).

a Screw the syringe into the valve (see a in Figure 4-13).

Screw the syringe into the valve port until it contacts the seal washer, 
then turn the syringe an additional 1/6 to 1/4 turn. If leakage is 
observed, tighten a maximum of an additional 1/8 turn.

b Pull down the syringe plunger until it meets the plunger drive (see b in 
Figure 4-13).

c Tighten the plunger lock screw (see c in Figure 4-13 on page 135).

Make sure the plunger lock screw is secured tightly.

Valve

Plunger drive

Plunger lock screw
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Figure 4-13  Installing the syringe

12 If you:

• Replaced the primary pump syringe, skip to step 13.

• Replaced the secondary pump syringe, reconnect the HTS to the 
cytometer by following the procedure in Installing the HTS on 
page 179.

13 Refill the pump.

• (BD LSR II and BD LSRFortessa) Verify that the cytometer is still in 
Run mode.

• (BD FACSCanto II) Turn on the cytometer.

• Reattach the sheath line and filter in back of the HTS.

• (BD FACSCanto, BD LSR II, and BD LSRFortessa) Turn on the HTS.

Valve

Syringe

Plunger drive

Plunger lock
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• (BD LSR II and BD LSRFortessa) Select HTS > Prime to prime the 
fluidics until the plunger barrel is full of sheath fluid. If you see any 
bubbles, continue priming until the bubbles are gone.

• (BD FACSCanto and BD FACSCanto II) Select Cytometer > Fluidics 
Startup to perform a fluidics startup. Verify that the plunger barrel is 
full of sheath fluid. If you see any bubbles, select HTS > Prime and 
repeat until all bubbles are gone.

Replacing the Probe

The probe is located at the end of the probe assembly arm. Replace the probe 
whenever it is bent or permanently clogged. A spare probe is included in the 
accessory kit.

Figure 4-14  Probe assembly components

1 Unscrew the fitting at the top of the probe (Figure 4-14).

2 Remove the probe by unscrewing it from the arm, and discard the probe 
into a biohazard sharps container.

All cytometer surfaces and hardware that come in contact with biological 
specimens can transmit potentially fatal disease. Use universal precautions 
when replacing the probe. Wear suitable protective clothing, eyewear, and 
gloves. 

Arm

Fitting

Probe
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3 Install a new probe.

4 Reattach the fitting at the top of the probe.

Replacing the Quick-Connector O-Rings

The sheath and waste lines are attached to the cytometer interface panel and the 
HTS using quick-connectors. There is an additional waste line attached to the 
cytometer waste tank using a quick-connector. Replace the quick-connector 
O-rings once a year or whenever a connector is leaking.

1 Disconnect the quick-connector.

2 Remove the O-ring using a flat, small screwdriver. Discard the O-ring as 
biohazardous waste.

3 Install a new O-ring, pushing it into place with your thumbs.

4 Reconnect the quick-connector.

All cytometer surfaces that come in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when changing 
O-rings. Wear suitable protective clothing, eyewear, and gloves. 

O-ring
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Replacing the SIT Protector and O-Ring (BD LSR II 
and BD LSRFortessa)

The SIT protector is a modified sleeve that prevents the sample injection tube 
from bending during installation of the HTS sample coupler. An O-ring between 
the SIT protector and the tube retainer keeps the protector in place. Replace the 
O-ring when the SIT protector slips down by itself.

1 Remove the safety cover from the HTS.

2 Detach the sample coupler from the cytometer SIT.

3 Remove the SIT protector.

Unscrew the tube retainer and slide the SIT protector straight down.  

All cytometer surfaces that come in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when changing 
O-rings. Wear suitable protective clothing, eyewear, and gloves. 

To avoid bending the SIT, do not slide the SIT protector at an angle. 

SIT protector

Tube retainer
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4 Slide the tube retainer down the metal tubing to find the O-ring.

If the O-ring is stuck inside the retainer, push the retainer to the top of the 
tubing and work it down at an angle until the O-ring is free.

5 Remove the O-ring and discard it as biohazardous waste.

6 Install a new O-ring and slide it to about the middle of the tube.

O-rings are included in the accessory kit.

7 Slide the SIT protector straight onto the SIT. 

8 While holding the tube, gently push up on the retainer screw and screw it 
on to secure it.

9 Reattach the sample coupler to the cytometer SIT.

a Slide the sample coupler onto the SIT until you reach a hard stop. 

Make sure the sample coupler tubing is not kinked or twisted. 

b Hold the coupler with one hand while you tighten the top nut with the 
other hand. 

Note that there should be a gap between the tightening nut and the 
bottom of the SIT protector. If you don’t see a gap, unscrew the tube 
retainer, push the SIT protector all the way up, and retighten the tube 
retainer.

To avoid bending the SIT, do not slide the SIT protector at an angle. 

O-ring
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Placing the HTS in Long-Term Storage

To prevent salt deposits from forming in the fluidics system, perform the 
following procedure if you will not be using your HTS for a week or more. See 
Cleaning the HTS on page 169.

Placing the HTS in Long-Term Storage (BD LSR II and 
BD LSRFortessa)

1 Remove the HTS safety cover.

2 Locate and loosen the positioning screw that secures the HTS to the 
cytometer support bracket (Figure 4-15 on page 140).

Figure 4-15  Loosening the positioning screw

3 Grasp the sides of the HTS and slide it forward until it meets the stop in the 
cytometer support bracket.

All cytometer surfaces that come in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when handling 
cytometer components. Wear suitable protective clothing, eyewear, and 
gloves. 

Positioning screw

Support bracket
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4 Lift the HTS off of the cytometer support bracket by doing the following:

a Slightly lift the HTS to clear the positioning screw.

b Being careful not to strain the sheath tubing, slide the HTS towards 
you until you can access the filter.

This allows you better access to the connections on the back of the HTS.

5 Detach the sheath line from the sheath port on the back of the HTS 
(Figure 4-16 on page 141).

Press the metal button to release the connector. Leave the line attached to 
the cytometer interface panel.

Figure 4-16  HTS sheath and waste lines

6 Connect the purging assembly line to the sheath port.

The purging assembly line is located in the spares kit.

7 Put the end of the purging assembly line into a 500-mL beaker containing 
DI water.

To prevent personal injury or damage to the HTS, do not slide the HTS out 
so far that it becomes unbalanced or the strain of the tubing bends the SIT.

filter

Sheath connector

HTS sheath line
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8 Put the safety cover on the HTS.

9 Select HTS > Prime and repeat nine times.

Priming will replace the sheath fluid with DI water.

10 Remove the end of the purging assembly line from the DI water and lay it 
on the benchtop.

11 Remove the purging assembly line.

12 Detach the HTS from the cytometer by following the steps in Removing the 
HTS on page 166.

13 Remove the HTS base plate.

a Unscrew the two thumbscrews on each side of the base plate.

Beaker of DI water

Purging assembly line

Sheath connector in port
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b Pull the base plate toward you until it disengages from the cytometer 
support bracket.

c Store the base plate with the HTS.

Placing the HTS in Long-Term Storage (BD FACSCanto and 
BD FACSCanto II)

1 Ensure that the sample coupler is installed and the HTS is turned on.

2 Perform a fluidic shutdown.

See Fluidics Shutdown on page 110 for details.

3 If required, remove the HTS from the cytometer.

See Removing the HTS on page 166. 

Cytometer
support bracket

Thumbscrew Thumbscrew

Base plate
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Unscheduled Maintenance

Perform the following procedures when necessary or when you are directed to do 
so by a BD Biosciences service representative.

• Homing the Sample Probe on page 144

• Priming the HTS on page 145

• Performing a Motion Test on page 146

• Verifying the Sample Probe Position on page 147

• Inspecting the Thumbscrew Fittings on page 149

• Inspecting the Hexagonal Fittings on page 150

• Declogging the SIT on page 150

Homing the Sample Probe

During normal operation, the sample probe goes through a homing sequence 
during initialization. Perform the following procedure to manually send the 
probe to the home position, or when directed by a BD Biosciences service 
representative during troubleshooting.

1 (BD LSR II and BD LSRFortessa) Place the cytometer in Run mode, and 
ensure that the sample coupler is installed.

The software automatically primes the HTS pumps during a homing 
operation. To prevent pressure from building in the flow cell, the cytometer 
must be in Run mode before the homing sequence begins. If you try to run 
the Home command when the cytometer is not in Run mode, the software 
indicates that the fluidic system is not ready.

(BD FACSCanto and BD FACSCanto II) Ensure that the sample coupler is 
installed and the HTS is turned on.
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2 Select HTS > Home.

3 Verify that the HTS properly performs the following homing sequence:

a The probe moves to the home position, if it is not already there.

b The probe moves up. 

c The plate holder moves left, and then slightly forward.

d The probe moves down.

e The plate holder moves right to the home position.

After this sequence, the valves initialize (priming occurs) and a completion 
dialog opens.

4 Click OK.

Priming the HTS

Prime the HTS when you set it up for the first time (for example, after a depot 
repair procedure), when you notice bubbles in the pump syringe barrel, or to 
clear a clog in the HTS fluidics. The Prime command automatically primes both 
pumps.

1 (BD LSR II and BD LSRFortessa) Ensure that the sample coupler is 
installed, and place the cytometer in Run mode.

To prevent pressure from building in the flow cell, the cytometer must be in 
Run mode before priming begins. If you try to run the Prime command 
when the cytometer is not in Run mode, the software indicates that the 
fluidic system is not ready.

(BD FACSCanto and BD FACSCanto II) Ensure that the sample coupler is 
installed and the HTS is turned on.

2 Select HTS > Prime.
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3 Verify that the pumps are primed and the HTS tubing fills with sheath 
fluid.

Once priming is complete, a completion dialog opens.

4 Click OK.

Performing a Motion Test

You might need to perform a motion test when you set up the HTS for the first 
time (for example, after a depot repair procedure), when axis movement is 
suspect, or when you are directed to do so by a BD Biosciences service 
representative during cytometer troubleshooting.

Note that this test executes the same sequence whether a 96- or 384-well plate is 
selected. For the most accurate troubleshooting, use a 384-well plate to verify 
that the mechanism reaches the extreme positions.

1 Select HTS > Motion and Position Test.

The Motion and Position Test dialog opens.

2 Select the plate type from the menu.

After you select the plate type, the Motion Test button becomes enabled.

3 Install the corresponding plate onto the plate holder and replace the safety 
cover.
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4 Click Motion Test.

5 Verify that the sample probe properly performs the following homing 
sequence:

a The probe travels to the home position.

b The probe moves up, and then moves to the extreme positions for a 
selected plate type.

c The probe returns to the injection port and a completion dialog opens.

6 Click OK.

If the motion test fails, contact your local BD Biosciences service 
representative.

Verifying the Sample Probe Position

This test positions the probe at the center of the nearest and farthest wells on a 
plate so you can visually verify the mechanical positioning of the probe.

To run this test, you must select a plate type in BD FACSDiva software and install 
the corresponding plate on the plate holder. The test can be run with a 96- or 
384-well plate.

1 Select HTS > Motion and Position Test.

The Motion and Position Test dialog opens.

2 Select the plate type from the menu.
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After you select the plate type, the Position Test button becomes enabled.

3 Install the corresponding plate onto the plate holder and replace the safety 
cover.

4 Click Position Test.

5 Verify that the sample probe properly performs the following sequence:

a The probe travels to the home position.

b The probe moves up, and then moves to well A1.

The Position Test dialog opens.

6 Remove or open the safety cover and verify that the probe is in the center 
of the nearest well (position A1).

7 Replace or close the safety cover, then click OK.

The probe moves to well H12 and the Position Test dialog opens.

8 Remove or open the safety cover and verify that the probe is in the center 
of the farthest well (position H12).

9 Replace or close the safety cover and click OK.

The probe returns to the injection port and a completion dialog opens.

10 Click OK.
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Reinitializing the HTS

If you switch off the HTS, and then switch it back on again while the software is 
running, you must reinitialize the HTS.

1 Select HTS > Reinitialize.

A completion dialog opens.

2 Click OK.

Inspecting the Thumbscrew Fittings

Thumbscrew fittings are installed in the following tubing locations. Check and 
tighten these thumbscrews periodically, and replace them when needed.

• Primary pump valve to probe. There are male thumbscrew fittings at both 
ends of the tubing.

• Sample injection tubing. There is a male thumbscrew fitting at the sample 
injection port/wash station and a female thumbscrew fitting at the 
extension tubing to the secondary pump valve.

• Extension tubing to the secondary pump valve. There is a male thumbscrew 
fitting at the sample injection tubing end.

All cytometer surfaces that come in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when handling 
cytometer components. Wear suitable protective clothing, eyewear, and 
gloves.
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Inspecting the Hexagonal Fittings

Hexagonal male fittings are located at the following locations. Check and tighten 
these fittings periodically, and replace them when needed.

• Left port of the primary pump

• Top, left, and right ports of the secondary pump

NOTE Valves contain sealing washers in each port. Over-tightening the fittings 
can compress the seal washers resulting in a blocked port. Insert a fitting or 
syringe into a port until it contacts the seal washer, then turn the fitting or syringe 
an additional 1/6 to 1/4 turn. If leakage is observed, tighten a maximum of an 
additional 1/8 turn.

Declogging the SIT

Perform this procedure to dislodge a clog in the SIT only when instructed to do 
so by BD Biosciences. You need a cleaning stylus to complete this procedure.

1 Remove the sample coupler.

All cytometer surfaces that come in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when handling 
cytometer components. Wear suitable protective clothing, eyewear, and 
gloves.

All cytometer surfaces that come in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when handling 
cytometer components. Wear suitable protective clothing, eyewear, and 
gloves. 

To avoid a service call, do not insert the cleaning stylus all the way into the 
SIT. Allow at least an inch of the stylus to protrude from the end of the SIT 
while declogging.
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2 About one inch from one end of the cleaning stylus, bend it at a 90° angle.

Bending the end of the cleaning stylus prevents you from inserting it too far 
into the SIT.

3 Hold the bent end of the cleaning stylus, and thread about three-quarters of 
the stylus up into the SIT (see Figure 4-17).

Figure 4-17  Declogging the SIT

4 Gently pull the cleaning stylus most of the way out of the SIT and then 
push it back in. Repeat several times.

5 Remove the cleaning stylus from the SIT, rinse the stylus with 
BD FACSClean solution followed by DI water, and dry the stylus.

6 Replace the sample coupler.

7 Select HTS > Prime.

Cleaning stylus

SIT
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5

Troubleshooting

The tips in this section are provided to help you troubleshoot issues that might 
arise when using the HTS. For additional troubleshooting assistance, see the 
appropriate cytometer user’s guide.

If additional assistance is required, contact your local BD Biosciences service 
representative. See Technical Assistance on page xi.

Troubleshooting suggestions in this chapter are grouped under the following 
headings:

• HTS Troubleshooting on page 154

• Acquisition Troubleshooting on page 155

• BD FACSDiva Troubleshooting on page 158
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HTS Troubleshooting
Observation Possible Causes Recommended Solutions

Bubbles in sample wells Mixing volume is too great Reduce the mixing volume. See 
Loader Settings on page 35, 
Sample Well Volumes on page 35, 
and Mixing on page 36 for 
recommendations.

Too many mixes Reduce the number of mixes.

Insufficient sample volume Increase the sample volume.

Leaking around sample 
coupler or cytometer SIT

Coupler or tube retainer is 
loose or worn

Check the fittings and tighten 
them as needed. 

Leaking around pump 
syringes

Fitting is loose Tighten the fitting, and replace it 
if necessary. See Inspecting the 
Thumbscrew Fittings on 
page 149.

(BD LSR II and 
BD LSRFortessa) DCM 
system running when 
tube arm is to the side

Acquisition switch is in tube 
mode

Switch to plate mode.

Bubbles in waste tank No antifoam concentrate is 
being used

Add 500 µL Sigma Antifoam A 
Concentrate to the waste tank.

Fluid accumulating 
around the injection 
port/wash station

Sample probe assembly is 
bent

Replace the sample probe 
assembly.

Clogged wash station • Add water to the injection port/
wash station. Insert the 
cleaning stylus into the drain 
on the side of the wash station.

• Replace the wash station 
assembly.

Sheath float switch time-
out error during sheath 
exchange

Air in the fluid lines
(BD FACSCanto and 
BD FACSCanto II)

• Select Cytometer > Cleaning 
Modes > Prime after Tank 
Refill.

• Bleed the air out of sheath filter.
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Acquisition Troubleshooting
Observation Possible Causes Recommended Solutions

Unexpectedly low event 
rate, or no events in 
plots

Sheath is not pressurized (BD LSR II and BD LSRFortessa) 
Ensure that the pressure relief valve 
on the cytometer sheath tank is in the 
closed position.

Sample injection tubing is 
kinked or damaged

Replace the tubing. See Replacing the 
Sample Injection Tubing on page 123.

Sampler coupler tubing is 
kinked or damaged

Replace the tubing. See Replacing the 
Sample Coupler and Tubing on 
page 130.

Clogged probe Run the daily cleaning procedure to 
clean the probe. See Daily Cleaning 
on page 112.

If the probe remains clogged, replace 
it. See Replacing the Probe on 
page 136.

Clogged SIT Check for clogs in the SIT using the 
cleaning stylus. See Declogging the 
SIT on page 150 for procedure. See 
Table A-2 on page 161 for cleaning 
stylus ordering information.

If the SIT remains clogged, replace it. 
See Replacing the Sample Injection 
Tubing on page 123.

Incorrect cytometer 
settings

• Ensure that the cytometer settings 
are correct.

• Run setup controls to optimize 
cytometer settings for the sample 
type.
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Unexpectedly low event 
rate, or no events in 
plots (continued)

Waste tank back pressure • Ensure that the waste fittings are 
connected and not damaged.

• (BD LSR II and BD LSRFortessa) 
Ensure that the waste lines are not 
kinked.

• Ensure that antifoam concentrate 
is added to the waste tank.

Cytometer malfunction • Manually run a tube of beads and 
verify that events appear in plots.

Bubble in the sample 
well(s)

Gently tap the plate to ensure that all 
wells are bubble-free, then reacquire 
the sample.

Bubbles in the flow cell Ensure that BD FACS sheath solution 
with surfactant is used during plate-
based acquisition.

Insufficient sample or no 
sample in the well

Ensure that there is sufficient sample 
in the well.

Bubbles in the syringe Prime the HTS. Select HTS > Prime.

Filter cap is wet (BD FACSCanto and BD FACSCanto 
II) Replace the filter cap.

Unexpectedly low 
number of events 
recorded 

Insufficient stopping 
criteria

Make sure to set the target number of 
events high enough that you do not 
run out of events before you reach the 
software-based acquisition time 
(sample volume/sample rate).

Acquisition Troubleshooting (continued)
Observation Possible Causes Recommended Solutions
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High carryover Mixing volume is too great Decrease the mixing volume.

Too many mixes Reduce the number of mixes.

Sample volume is too large Decrease the sample volume.

Wash volume is too low Increase the wash volume.

Sample coupler is not 
completely installed

Slide the sample coupler on the SIT 
until you reach a hard stop.

Damaged injection tubing Replace the sample injection tubing. 
See Replacing the Sample Injection 
Tubing on page 123.

Acquisition Troubleshooting (continued)
Observation Possible Causes Recommended Solutions
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BD FACSDiva Troubleshooting
Observation Possible Causes Recommended Solutions

System error Cover error Replace the cover and resume the 
run.

Back pressure error • Ensure that the waste line to 
the cytometer is properly 
installed and is not kinked.

• Ensure that the filter on the 
waste tank is not clogged.

Motion error Select HTS > Home and resume 
the run.

Pump error Select HTS > Home and resume 
the run.

Plots not refreshing Incorrect worksheet displayed Ensure that the global worksheet 
is displayed during a sequenced, 
plate-based acquisition. 

Run buttons not enabled No global worksheet is 
selected

Switch to the global worksheet 
view by clicking the Worksheet 
View button.

Well(s) not selected Select well(s).

(BD FACSCanto and 
BD FACSCanto II) HTS 
not included in cleaning 
modes

Sample coupler not installed Ensure that the sample coupler is 
installed before cleaning modes 
are selected.

No power Ensure that the HTS is powered 
on.

Cover is open Close the cover.
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Consumables and
Replacement Parts

This appendix provides a list of supplies and replacement parts for your HTS. To 
order spare parts and consumables from within the US, call 877.232.8995 or go 
to bdbiosciences.com. In other countries, contact your local BD Biosciences 
representative.

This information is correct at the time of publication. For up-to-date 
information, visit our website (bdbiosciences.com).

You will find the following in this appendix:

• Cytometer Supplies on page 160

• Maintenance Log on page 162
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Cytometer Supplies

The HTS is shipped with a preventive maintenance kit including replacement 
parts for one year of maintenance, and an accessory kit containing other 
replacement parts. Use the following part numbers if you need to order part 
replacements. Note that parts in the preventive maintenance kit can also be 
ordered individually. 

Table A-1  Preventive maintenance kit: part no. 337042

Item Part No. Kit Quantity

Glass syringe, 500 µL 344912 2

Tubing assembly, secondary pump to cytometer 
(BD LSR II and BD LSRFortessa)

335452 1

Tubing assembly, secondary pump to cytometer 
(BD FACSCanto and BD FACSCanto II)

339340 1

Tubing assembly, probe to primary pump 335454 1

Tubing assembly, injection port 335526 2

Probe and tubing assembly 34389017 1

HTS sheath filter (2) 335710 2

Quick-disconnect O-ring 343618 7

O-ring sleeve retainer (BD LSR II and 
BD LSRFortessa)

343620 1

Air filter 336218 1

Absorbent pad (BD LSR II, BD LSRFortessa, and 
BD FACSCanto)

343502 1

Injection tubing to secondary pump 335451 2
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Table A-2  Other replacement parts and reagents

Item Part No.

SIT protector assembly (BD LSR II and BD LSRFortessa) 335345

BD LSR II and BD LSRFortessa sheath line assembly 336076

BD LSR II and BD LSRFortessa waste line assembly 336077

BD FACSCanto sheath line assembly 7000949

BD FACSCanto waste line assembly 7000950

BD FACSCanto II sheath line assembly 700097807

BD FACSCanto II waste line assembly 700097707

Line declogger tool 343583

Air filter retainer 336474

5/16-inch open-ended wrench 337016

BD FACS sheath solution with surfactant 336524

BD FACSClean solution 340345

BD FACSRinse solution 340346

Anti-foam concentrate, 25-g bottle 334887

Cleaning stylus 343648

Purging assembly line (BD LSR II and BD LSRFortessa) 340088

HTS safety cover (BD LSR II, BD LSRFortessa, and 
BD FACSCanto)

640404

2-ft serial cable (BD FACSCanto) 640737

HTS catch tray (BD FACSCanto) 640576

HTS power/communication cable (BD FACSCanto II) 344368
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Maintenance Log

Use the following log to keep track of maintenance procedures on your HTS. You 
can photocopy the log and keep it next to the cytometer, or use it as a guide to 
design your own.

Daily Maintenance Procedure

Daily Cleaning page 112

Cytometer Inspection and Servicing

• Sample coupler

• Base plate, probe assembly, plate holder

• Sample probe

• Pumps

• Absorbent pad

page 116

Monthly Maintenance Procedure Month Completed (Initials/Date)

Monthly Cleaning page 119

Surface Inspection and 
Cleaning

page 121

Periodic Maintenance Procedure Completed (Initials/Date)

Replacing the Sample 
Injection Tubing

page 123

Replacing the HTS 
Sheath Filter

page 126

Cleaning the Air Filter page 128

Replacing the Sample 
Coupler and Tubing

page 130
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Replacing a Pump 
Syringe

page 132

Replacing the Probe page 136

Replacing the Quick-
Connector O-Rings

page 137

Replacing the SIT 
Protector and O-Ring 
(BD LSR II and 
BD LSRFortessa)

page 138

Placing the HTS in 
Long-Term Storage

page 140

Periodic Maintenance Procedure Completed (Initials/Date)
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Appendix B

Depot Repair Procedures

This appendix contains procedures to perform if your HTS needs repair and 
depot repair service is available in your region.

NOTE Depot repair procedures might be different outside the United States. 
Contact your local BD Biosciences service representative for information for your 
region.

The following procedures are covered in this appendix:

• Removing the HTS on page 166

• Cleaning the HTS on page 169

• Unpacking the Replacement HTS on page 177

• Installing the HTS on page 179

• Packing the HTS for Shipping on page 184
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Removing the HTS

Follow this procedure to detach your HTS from the cytometer to perform 
maintenance specified in this user’s guide, or before sending it in to 
BD Biosciences for depot repair.

NOTE If you are able to run the system, decontaminate the HTS before you 
remove it by performing the monthly clean procedure. See Monthly Maintenance 
on page 119. If you cannot run the system, decontaminate it after removal as 
described in Cleaning the HTS on page 169.

1 (BD LSR II, BD LSRFortessa, and BD FACSCanto) Switch off the HTS 
power.

2 Shut down the cytometer.

3 Remove or open the HTS safety cover.

4 Detach the sample coupler from the cytometer SIT.

a Unscrew the top nut.

b Pull the sample coupler down and away from the SIT, leaving the nut 
attached to the sample coupler.

5 Locate and loosen the positioning screw that secures the HTS to the base 
plate.

See Figure B-1 on page 167.

All cytometer surfaces that come in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when handling 
cytometer parts. Wear suitable protective clothing, eyewear, and gloves. 
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Figure B-1  Location of positioning screw (example of BD LSR II)

6 Grasp the sides (or back) of the HTS and slide it forward until it meets the 
stop in the base plate.

7 (BD FACSCanto II) Remove the probe (see Replacing the Probe on 
page 136) and the overflow reservoir. 

8 (BD FACSCanto) Remove the catch tray.

9 (BD FACSCanto, BD LSR II, and BD LSRFortessa) Lift the HTS off of the 
base plate by doing the following:

a Slightly lift the HTS to clear the positioning screw.

b Be careful not to strain the sheath tubing and slide the HTS towards 
you until you can access the filter.

This allows you better access to the connections on the back of the HTS.

10 Disconnect the sheath and waste lines from the cytometer.

To prevent personal injury or damage to the HTS, do not slide the HTS out 
so far that it becomes unbalanced.

Base plate
Positioning screw
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11 (BD LSR II, BD LSRFortessa, and BD FACSCanto) Disconnect the power 
and communication cables from the rear right side of the HTS. 

(BD FACSCanto II) Disconnect the interface/communication cable from the 
cytometer. If necessary, pull the HTS out slightly to access the cable, which 
is attached to the cytometer at the back-left corner of the HTS.

To detach the communication cable, unscrew the two connector screws and 
pull out the cable.

12 (BD FACSCanto II) Lift the front feet of the HTS just over the front edge of 
the enclosure and tilt the HTS at a 45° angle towards you to allow you 
access to the door sensor cable on the right side of the HTS. Unplug the 
door sensor cable by pulling back on the ferrule. Place the cable over the 
right side of the enclosure/carrier.

13 Carefully lift the HTS and place it on the benchtop next to the cytometer.

14 (BD LSR II, BD LSRFortessa, and BD FACSCanto) Remove the absorbent 
pad from the drip reservoir and discard it as biohazardous waste (Figure B-
2).

Power cable

Communication
cable
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Figure B-2  Drip reservoir containing absorbent pad (BD LSR II, BD LSRFortessa, and 
BD FACSCanto only)

15 Place the sample tubing and attached sample coupler inside the drip 
reservoir.

Cleaning the HTS

You must decontaminate both the internal fluidics and external surfaces of your 
HTS before it is repaired. If you were able to run a monthly clean before you 
removed the HTS, the internal fluidics are decontaminated. Skip to 
Decontaminating External Surfaces on page 175. If you were not able to run a 
monthly clean, proceed with the following section. 

All cytometer surfaces that come in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when cleaning 
the cytometer. Wear suitable protective clothing, eyewear, and gloves. 

Absorbent
pad
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Use a 10% bleach solution to decontaminate the internal fluidics and external 
surfaces of the HTS.

To prepare the bleach solution:

1 Pour 45 mL of DI water into a 100-mL beaker.

2 Carefully add 5 mL of undiluted bleach to the same beaker.

3 Gently swirl the solution to mix.

Decontaminating the Fluidics Manually

Materials Needed

• Household bleach

• DI water

• Disposable plastic pipettes

• Line declogger, part number 343583 from the accessories kit (for manual 
fluidics decontamination only)

To prevent shock, verify that the cytometer is turned off and the power 
cable is detached before you start cleaning.

To ensure that the 10% bleach solution retains its full germicidal effect, 
prepare a fresh solution daily.
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Cleaning the Fluidics

Perform this procedure to decontaminate the internal fluidics of a non-functional 
HTS.

1 Remove the sample probe and tubing that connects the probe to the 
primary pump. Discard the probe and tubing (Figure B-3 on page 171).

For details on removing the probe, see Replacing the Probe on page 136.

Figure B-3  Removing the sample probe and tubing

2 Pipette a 10% bleach solution into the injection port/wash station.

Using a disposable pipette, fill the injection port/wash station completely, 
being careful not to overfill it.

3 Connect the line declogger tool to the waste connector on the back of the 
HTS.

All cytometer surfaces that come in contact with biological specimens can 
transmit potentially fatal disease. Treat the sample probe and tubing as 
biohazardous waste and dispose of them according to local regulations.

Sample probe

Sample probe tubing
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Figure B-4  Attaching the declogger tool

4 Slowly pull back the plunger of the declogger tool until all of the bleach 
solution is drawn into the barrel. 

5 Disconnect the declogger tool and discard the bleach solution according to 
local regulations.

6 Repeat step 2.

7 Reattach the declogger tool, and slowly remove about half of the bleach 
solution. Allow the remaining bleach to sit for 30 minutes.

Keep the declogger tool attached to the waste port during the 30 minutes.

8 Use the declogger tool to remove the rest of the bleach solution.

9 Disconnect the declogger tool and discard the bleach solution according to 
local regulations.
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Rinsing the Fluidics

1 Pipette DI water into the injection port/wash station.

Using a disposable pipette, fill the injection port/wash station completely, 
being careful not to overfill it.

2 Connect the line declogger tool to the waste connector on the back of the 
HTS.

3 Slowly pull back the plunger of the declogger tool until all of the DI water 
is drawn into the barrel.

4 Repeat step 1 and step 3.

5 Disconnect the declogger tool and discard the DI water.

6 Carefully dry the declogger tool and return it to the HTS accessory kit.

7 Remove and discard the secondary pump valve tubing (A).

a Disconnect the top hex screw (B) from the secondary pump using the 
5/16-in. wrench in the accessory kit (Figure B-5).

All cytometer surfaces that come in contact with biological specimens can 
transmit potentially fatal disease. Treat the secondary pump valve tubing as 
biohazardous waste and dispose of it according to local regulations.
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Figure B-5  Hex screw on secondary pump

b Turn the sample injection port/wash station (C) slightly to disengage 
the magnetic force, then lift it up to expose the thumbscrew (D) on the 
sample injection tubing (E) and the thumbscrew (F) on the secondary 
pump valve tubing (A) (Figure B-6).

Figure B-6  Accessing the tubing

c Unscrew the thumbscrew (F) from the connector (G) and remove the 
secondary pump valve tubing (A) (Figure B-6).

8 Detach the sample coupler tubing from the secondary pump valve and 
discard the tubing as biohazardous waste.

9 Cover the open ports with parafilm or tape.

Hex screw (B)

Secondary pump

Secondary
pump valve

tubing (A)

Thumbscrew (F)

Sample injection 
tubing (E)

Sample injection 
port/wash station (C)

Connector (G)

Thumbscrew (D)
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Decontaminating External Surfaces

Materials Needed

• 10% bleach solution

• DI water

• Paper towels

Cleaning the Surface of the HTS

1 Saturate some paper towels with a 10% bleach solution.

2 Move the plate holder to the far left and wipe down the surface of the stage 
that was under the plate holder using the saturated paper towels (see 
Figure B-7 on page 176).

To prevent HTS damage, do not pour or squirt bleach solution directly 
onto the HTS.
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Figure B-7  HTS top view

3 Repeat step 2 moving the plate holder to the far right, front position, and 
then back position.

4 Clean the remaining external surfaces of the HTS using paper towels 
saturated with a 10% bleach solution.

Make sure all surfaces are clean.

5 Dispose of the paper towels used for cleaning as biohazardous waste.

6 Rinse all surfaces by repeating steps 1 through 5, substituting DI water for 
the bleach solution.

7 Allow the HTS to dry thoroughly.

Plate holder

Stage



 Appendix B: Depot Repair Procedures 177

Unpacking the Replacement HTS

NOTE If you are sending back an existing HTS for depot repair, save all shipping 
materials and ship the existing HTS in this new container. It contains paperwork 
for shipping and two labels verifying that the HTS you are returning was 
decontaminated.

Before You Proceed With Unpacking

• Make sure you have adequate space:

- On the floor near the cytometer to place the shipping container.

- On the table or bench near the cytometer to place the new HTS.

• Make sure you:

- Read through these instructions before attempting to unpack the new 
HTS.

- Are ready to install the new HTS. See Installing the HTS on page 179.

Lifting Heavy Objects

1 Stand in front of the object, and then sit on your heels (squat).

2 Place your hands under the base of the object, ensure the load is balanced, 
and bring the object as close to your lap as possible.

An HTS without a cover weighs approximately 22 lb. To prevent personal 
injury or damage to the HTS, follow the guidelines on Lifting Heavy 
Objects on page 177 to remove the replacement HTS from its shipping 
container.

To avoid personal injury or damage to the HTS, follow these guidelines for 
lifting heavy objects from the floor.
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3 While keeping your spine in a natural position and your head up, lift the 
object using the force of your legs.

Do not twist your back when lifting. Pivot on your heels.

Unpacking the HTS

1 With the arrows on the box pointing up, open the shipping container.

Remember to save all paperwork and shipping materials to repack the HTS 
to be returned.

2 Remove the top piece of foam and set it aside.

3 Using proper lifting techniques, carefully lift the HTS out of the container 
and place it on a table near the cytometer. 

4 Remove the HTS from the plastic bag.

5 Remove the small I-shaped piece of foam that secures the HTS probe 
assembly and plate holder, and set it aside.

The HTS is encased in plastic to protect it during shipment. The plastic can 
make the HTS slippery and difficult to grasp. To prevent personal injury or 
damage to the HTS, use caution when lifting the HTS out of the container.
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Installing the HTS

Installing the HTS (BD LSR II and BD LSRFortessa)

1 To avoid damaging the HTS probe, lower it into the injection port/wash 
station.

2 Place the HTS on the base plate. 

3 Make sure the HTS support legs fit into the bracket grooves. With the legs 
in the grooves, slide the HTS as far forward as possible.

4 Connect the power and communication cables to their respective ports on 
the rear right side of the HTS (see Figure B-8 on page 179).

Figure B-8  Connecting the power and communication cables (BD LSR II)

5 Connect the sheath line (with filter) and waste line to their respective ports 
on the back of the HTS.

Any cytometer surface that comes in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when handling 
cytometer hardware. Wear suitable protective clothing, eyewear, and 
gloves.

Power cable

Communication
cable
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6 Slide the HTS all the way back toward the cytometer being careful not to 
crimp the fluidics tubing or communication cable.

7 (BD LSR II) Tighten the positioning screw under the front of the base plate.

8 See Setting Up for Plate-Based Acquisition (BD LSR II and 
BD LSRFortessa) on page 28 to complete the installation of the HTS.

Installing the HTS (BD FACSCanto and 
BD FACSCanto II)

1 To avoid damaging the HTS probe:

• (BD FACSCanto) Lower it into the injection port/wash station.

• (BD FACSCanto II) Remove the probe and the overflow reservoir. See 
Replacing the Probe on page 136.

2 Install the HTS.

• (BD FACSCanto) Place the HTS on the base plate.

• (BD FACSCanto II) Open the doors to the enclosure and place the door 
sensor cable that is attached to the cytometer over the right side of the 
enclosure.

Bring the HTS close to the cytometer while you sit in a chair with the 
HTS in your lap. Make sure the HTS support legs fit into the bracket 
grooves. With the legs in the grooves, slide the HTS as far forward as 
possible.

3 Connect the cables.

• (BD FACSCanto) Connect the power and communication cables to 
their respective ports on the rear right side of the HTS (see Figure B-9 
on page 181).
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Figure B-9  Connecting the power and communication cables (BD FACSCanto)

• (BD FACSCanto II) Tilt the HTS at a 45° angle towards you to allow 
you access to the door sensor connector on the right side of the HTS. 
Plug the door sensor connector into the HTS, matching the white 
arrow on the plug with the arrow on the connector (see Figure B-10).

If necessary, slide the HTS in until you can connect the interface/
communication cable to the cytometer (see Figure B-11 on page 182). 
Tighten the two connector screws after the communication cable is 
attached.

Figure B-10  Plugging the door sensor cable into the HTS (BD FACSCanto II only)

Power cable

Communication 
cable

Door sensor cable
(Match the arrow on the plug with the 
arrow on the HTS connector.)
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4 (BD FACSCanto II) Install the overflow reservoir with the lip facing 
towards you, and place the overpressure tubing into the reservoir (see 
Figure 1-7 on page 19).

5 Connect the sheath line (with filter) and waste line to their respective ports 
on the back of the HTS (or back of the cytometer for BD FACSCanto II) 
(see Figure B-11).

NOTE The white connector on the BD FACSCanto II is not used for the 
HTS.

Figure B-11  Connecting BD FACSCanto II interface cable to HTS

6 (BD FACSCanto) Install the rear catch tray.

a Route the sample coupler underneath the catch tray tongue and sample 
coupler slot.

b Push the tray in, making sure the coupler line is not crimped or kinked. 
The clamp on the tray is used for the sample coupler when it is not in 
use.

Interface/
communication cable

Waste line (orange)

Sheath line (blue)
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Figure B-12  Catch tray installed at the back of the BD FACSCanto

7 Slide the HTS all the way back toward the cytometer being careful not to 
crimp the fluidics tubing or communication cable.

8 (BD FACSCanto II) Install the probe (see Replacing the Probe on 
page 136).

9 Tighten the positioning screw under the front of the base plate/enclosure.

10 See Setting Up for Plate-Based Acquisition (BD FACSCanto and 
BD FACSCanto II) on page 32 to complete the installation of the HTS.

Clamp for 
sample 
coupler
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Packing the HTS for Shipping

Use the following procedure to pack the inoperable HTS prior to shipping.

NOTE Pack the HTS in the shipping container that contained the replacement 
HTS. It should contain the following:

• Shipping paperwork

• Decontamination label

• Small I-shaped piece of foam

• Plastic bag

• Top piece of foam

• Bottom piece of foam

Placing the HTS into its Shipping Container

1 Make sure the HTS was decontaminated according to the procedures in 
Cleaning the HTS on page 169.

2 Disconnect the sheath and waste lines from the HTS.

3 Disconnect the interface/communication cable from the HTS.

4 (BD FACSCanto II) Disconnect the door sensor cable from the HTS.

5 Initial and date the decontamination labels. Stick one on the plate holder 
and the other on the outside of the shipping carton.

Enter the initials of the person who decontaminated the HTS.

6 Fill out the Cytometer Return form.
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7 Place the small I-shaped piece of foam between the probe assembly arm and 
plate holder to secure them. 

8 Slide the HTS into the plastic bag. 

9 Using proper lifting techniques, place the bagged HTS in the shipping 
container, making sure the arrows on the box are pointing up.

For proper lifting techniques, see Lifting Heavy Objects on page 177. Place 
the HTS on top of the bottom piece of foam.

10 Place the top piece of foam over the HTS.

11 Lay the Cytometer Return form on top of the foam, and close and seal the 
flaps of the shipping container.

The plastic might make the HTS slippery and hard to grasp. To prevent 
personal injury or damage to the HTS, use caution when placing the HTS in 
the shipping container.
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Appendix C

Automation

This appendix describes the remote automation server application programming 
interface (API).

The following topics are covered in this appendix:

• About Automation on page 188

• Establishing a Connection to the Automation Server on page 188

• Command Syntax on page 189

• API Command List on page 191

• Error Handling and Return Codes on page 195
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Automation

About Automation

Automation for the HTS is a function that allows you to connect to 
BD FACSDiva software (via a server socket) and issue commands, such as 
creating experiments and recording plates through the use of a published 
command API. It is designed to help you set up a walkaway type of automation 
process in which clients can coordinate interactions between external hardware 
(such as robotics), third-party software, the BD FACSDiva software application, 
and the cytometer.

Establishing a Connection to the Automation Server

To run plate automation you can use your own proprietary software application 
to connect to the BD FACSDiva API. The application can be run from the same 
computer that is connected to the instrument or from a different computer that is 
located on the network. Users who want to use this new process would typically 
write an application that acts as a driver, in terms of switching between their 
robotics application (which adds and removes plates) and the BD FACSDiva 
software application (which configures and runs plates once they are loaded).

The BD FACSDiva software remote automation server allows clients to connect 
to the automation server Port 247. Once BD FACSDiva software has been 
installed, client applications use the IP address of this computer and the Port 
address 247 to establish a connection with the application.

To establish a connection:

1 Start BD FACSDiva software and log in to the application.

2 Locate the server icon on the workspace toolbar and click it to turn the 
server on.

 Server icon off  Server icon on
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3 The server starts up and is ready to accept client connections. The client 
application can now connect to the server, using the IP address and the port 
address, and can now send published commands to the automation server.

- Use a java.net.Socket object for a Java client.

- Use a System.Net.Sockets.TcpClient object for a C# or C++ client.

NOTE The communications channel established between the server and the 
client is a synchronous communication channel. The reason for implementing 
synchronous communications is so that the client is blocked by the server until 
the process initiated by the passed command has either finished its process or has 
stopped due to an error. This allows the client to know exactly when a process is 
complete.

Command Syntax

All of the commands that are part of the remote automation API will follow the 
same syntactical design in terms of issuing commands to the automation server. 
The following is an example which shows the structural pattern to be used when 
assembling these types of commands:

• CmdName. The published name of the command as outlined in this 
document (case sensitive).

• ParamName. Any published parameters for the specified command (not 
case sensitive).

• ParamValue. Any published parameter values that coincide with the 
specified parameter name (not case sensitive).

• Brackets [ ]. The beginning and ending delimiters for a list of parameter 
name/value pairs.

• Commas. The delimiter used to separate multiple parameters.

• Equals Sign. Used to associate a parameter value with a parameter name.
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Syntax Example

CmdName[ParamName1=ParamValue 1, ParamValue2=ParamValue 2]

Additional Information

• Spaces are allowed within the command parameter section. For example, 
they are allowed between the brackets [ ], but are not required. Only the 
spaces within the parameter value area (between the quotes “”) will be 
preserved.

• Only one command can be sent to the server at a time. The client must wait 
until it receives the return code before sending any subsequent commands.

• Each command is sent to the server as a byte array and the data returned to 
the client is also sent as a byte array. Both arrays have a size limit set to 
256 bytes.
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API Command List

Table C-1  New Experiment Command

Command Name
Command 
Description

Parameter Names
Parameter 
Values

Parameter 
Description

CmdCommNewExp Creates a new 
experiment 
within the 
currently 
selected Diva 
folder.

Name (optional) <user-defined 
name>

The display 
name for the 
experiment in 
the 
experiment 
Browser.

Table C-2  New Plate Command

Command Name
Command 
Description

Parameter 
Names

Parameter 
Values

Parameter 
Description

CmdCommNewPlate Creates a new 
plate within 
the currently 
selected Diva 
experiment.

Name 
(optional)

<user-defined 
name>

The display 
name for the 
plate in the 
experiment 
Browser.

Type 
(mandatory)

96FlatWell

96UWell

96VWell

384FlatWell

The type of plate 
to be created 
within the open 
experiment.
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Table C-3  Setup Plate Command

Command Name
Command 
Description

Parameter Names Parameter Values
Parameter 
Description

CmdCommSetupPlate Configures 
the currently 
selected 
Diva plate in 
terms of 
creating the 
specimen 
and setting 
the Loader 
settings.

Throughput 
(optional)

High (Default)

Standard

High 
represents 
high- 
throughput 
mode and 
standard 
represent 
standard 
throughput 
mode.

SampleFlowRate 
(optional)

Min Value: 0.5

Max Value: 3.0

Increment Value: 
0.5

Default Value: 
1.0

The flow 
rate to use 
for the 
sample 
measured as 
µL/sec.

SampleVolume 
(optional)

Min Value: 2

STD Mode Max: 
200

HTS Mode Max: 
10

Increment Value: 
1

Default Value: 2

The volume 
used for the 
sample 
measured as 
µL.
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CmdCommSetupPlate 
(continued)

Configures 
the currently 
selected 
Diva plate in 
terms of 
creating the 
specimen 
and setting 
the Loader 
settings. 
(continued)

Mixing Volume 
(optional)

Min Value: 5

(BD LSR 
platform) Max 
Value: 80

(BD FACSCanto 
platform) Max 
Value: 100

Increment Value: 
1

Default Value: 50

The mixing 
volume to 
use 
measured as 
µL.

Mixing Speed 
(optional)

Min Value: 25

Max Value: 250

Increment Value: 
1

Default Value: 
200

The mixing 
speed to use 
measured as 
µL/sec.

NumOfMixes 
(optional)

Min Value: 0

Max Value: 5

Increment Value: 
1

Default Value: 2

The number 
of times to 
perform the 
mixing 
operation.

WashVolume 
(optional)

Min Value: 200

Max Value: 800

Increment Value: 
1

Default Value: 
200

The washing 
volume to 
use 
measured as 
µL.

Command Name
Command 
Description

Parameter Names Parameter Values
Parameter 
Description
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Table C-4  Setup Acquisition Command

Table C-5  Run Plate Command

Command Name
Command 
Description

Parameter 
Names

Parameter 
Values

Parameter 
Description

CmdCommSetupAcquisition Sets up the 
acquisition 
rules used 
for 
acquiring 
data.

NumOfEvents 
(optional)

Min Value: 
1

Max Value: 
N/A

Increment 
Value: 1

Default 
Value: 
10,000

The stopping 
rule related 
to the 
number of 
events to 
record.

Command Name
Command 
Description

Parameter 
Names

Parameter 
Values

Parameter 
Description

CmdCommRunPlate Runs the 
currently 
selected 
Diva plate.

N/A N/A N/A
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Error Handling and Return Codes

Table C-6  New Experiment Command

Table C-7  New Plate Command

Table C-8  Setup Plate Command

Status Type Return Code

Command Completed Successfully 0

Unknown Error -1

Invalid Command Name 1000

Invalid Experiment Name 1001

Status Type Return Code

Command Completed Successfully 0

Unknown Error -1

Invalid Command Name 1000

Invalid Plate Name 1001

Experiment Not Open 1002

Unable To Create Plate 1003

Invalid Plate Type Specified 2000

Status Type Return Code

Command Completed Successfully 0

Unknown Error -1

Invalid Command Name 1000
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Table C-9  Setup Acquisition Command

Table C-10  Run Plate Command

Experiment Not Open 1002

Unable To Create Specimen 1004

Target Plate Not Found 1005

Status Type Return Code

Command Completed Successfully 0

Unknown Error -1

Invalid Command Name 1000

Experiment Not Open 1002

Unable To Create Specimen 1004

Target Plate Not Found 1005

Status Type Return Code

Command Completed Successfully 0

Unknown Error -1

Invalid Command Name 1000

Experiment Not Open 1002

Unable To Create Specimen 1004

Target Plate Not Found 1005

Instrument Not Connected 1006

Unable To Run Plate 2100

Status Type Return Code
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Index

A

acquisition
automatic 59
Dashboard 43
data 91, 92
defaults 51, 54
high-throughput mode 34, 35, 51
manual 61
modes 34
optimizing settings for 87
plate-based See plate-based acquisition
standard mode 34, 35, 51
status 48
status record 50, 92
time equation 52
troubleshooting 155
tube-based 103

air filter, cleaning 128
Analysis view

components 62
functionality 65

analysis, automating 13, 99
application programming interface 

(API) 188
application window components 40
apply

analysis template to wells 54
application settings 55
cytometer settings to wells 54

assistance, technical xi

automation
about xii, 188
command list 191, 192, 193, 194
command syntax 189, 190
connecting to server 188
error codes 195
return codes 195

available well volume 36

B

base plate
inspection and service 117
removing 142

baseline restore (BLR) xii, 53
batch analysis 99, 101
BD High Throughput Sampler See HTS
Browser 42

C

carryover, minimizing 37
cleaning

air filter 128
daily 112–116
fluidics 171
HTS 169–176
Long Clean 121
monthly, BD FACSCanto 121
monthly, BD LSR II 119–121
surfaces 121
template 113
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color indicators
sheath fluid 108
well status 48

compensation 50, 89
components

HTS 17, 18, 19
workspace 40

consumable part numbers 160
controls, acquisition 43
conventions, user’s guide x
copy and paste

instrument settings 58
wells and specimens 55

coupler, sample
about 19, 20
inspection and service 116
replacing 130

creating compensation controls 50
customer support xi
cytometer

connectors 21–23
interface panel 21–23
optimizing settings 87–89
sample injection tube (SIT) 26
setting up 28, 32
support bracket 21

D

daily
cleaning 112–116
maintenance 112–118

data
acquiring 91, 92
analyzing 95–102

dead volume 36
decontaminating

external surfaces 175

fluidics
automatically 119
manually 170

defaults
acquisition settings 14, 51
HTS settings 54

deleting wells and settings 54
depot repair See repair procedures
door sensor cable, BD FACSCanto II 20

E

error messages
acquisition 155
hardware 154
software 158

experiment
creating 72
exporting 93
templates 93

Experiment Layout
accessing from shortcut menu 54
events to record 81
labels 79
setup 79–82

exporting
experiment templates 93
plate template 85
well settings and files 54

external surfaces, decontaminating 175

F

fittings
hexagonal, inspecting 150
thumbscrew, inspecting 149
tightening 131, 141, 150, 167

fluidic modes
fluidics shutdown 110
fluidics startup 72
sheath exchange 108
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fluidics
cleaning 171
manually decontaminating 170
modes 14
rinsing 173
shutdown, BD FACSCanto 110
startup, BD FACSCanto 72
tubing 18, 20

fluorophore labels 50

G

globally unique identifier (GUID) 102

H

hardware
basic functionality 14
components 17
installation 15, 179
part replacement 122
plate sizes 14

hazard symbols x
hexagonal fittings, inspecting 150
High Throughput Sampler See HTS
high-throughput mode 34, 35, 51
HTS

decontaminating for repair 169
hardware See hardware.
installing 179, 180
introduction 13
long-term storage 140
pausing 92
priming 145
reinitializing 149
settings 52, 53
stopping 93
unpacking replacement HTS 177

I

import well settings 54
injection

port interface 18, 20
tubing, replacing 123

inspection
cytometer 116
fittings 149, 150
surface 121

Inspector window 44
instrument settings 58
interface panel, cytometer 21–23

K

keywords
assigning 57, 86
viewing assignments 66, 95

L

labels for fluorophores 50
loader settings 35
long-term storage of HTS 140

M

maintenance
daily 112–118
log 162
monthly 119–122
part replacement schedule 122
unscheduled 144–151

menus, software 41
mixing

number of cycles 54
optimizing 36
speed 53
volume 36, 53
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modes
default HTS settings 54
default settings 51
fluidic 14
high-throughput 34, 35, 51
plate 24, 28
soft standby 31
standard 34, 51
tube 24, 103

monthly
cleaning

BD FACSCanto 121
BD LSR II 119–121

maintenance 119–122
motion test 146

N

number of mixes 54

O

optimizing cytometer settings 87–89
ordering information

how to 159
replacement parts 159–161

O-rings, replacing
quick-connector 137
SIT protector 138

overflow reservoir 20

P

packaging for shipping 184
part replacement

air filter 128
hexagonal fittings 150
injection tubing 123
instrument supplies 160
ordering information 159–161
O-rings 137, 138

part numbers 160
plates 74
probe 136
pump syringes 132
reagents 161
sample coupler and tubing 130
schedule 122
sheath filter 126
SIT protector 138
thumbscrew fittings 149

perform compensation setup 55
perform panel analysis 54
phone numbers

ordering parts 159
technical support xi

plate
automation See automation
compatibility 74
filter 46
holder 20, 88, 117
icons 49
layout view 48
legend 46
mode 24, 28
orienting 88
printing records 92, 97
rearranging samples on 57
sizes supported 14
template 85
toolbar 47

Plate Interface 44
plate-based acquisition

running samples 69–94
setting up 28–33

position test 147
probe

assembly 18, 20
homing 144
inspection and service 118
preventing damage 87
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replacing 136
verifying position 147
wash volume 53

pumps
inspection and service 118
replacing syringes 132
secondary 19, 20

Q

quitting software 110

R

rate, sample flow 52
records

acquisition status 50, 92
printing 97

renaming specimen 55
repair procedures

cleaning the HTS 169–176
decontaminating exterior 175
decontaminating fluidics 170
installing 179, 180
packing HTS for shipping 184
removing the HTS 166
rinsing fluidics 173
unpacking replacement HTS 177

replacement HTS, unpacking 177
returns, packaging 184
run sequence

automatic 59
manual 61

S

safety
biological 28
interlock feature 91
lifting heavy objects 177
tube-based acquisition 105

unpacking replacement HTS 177
sample coupler

about 26–31
BD FACS Canto II 20
BD LSR II 19
inspection and service 116

sample volume 52
samples

aspirated volume 52
flow rate 52
minimum volume 52
processing, overview 34
running 69–94
sample injection tube (SIT) 26
setting volume 54

servicing cytometer 116
settings

carryover 37
HTS 51
mixing 36
optimizing for acquisition 87
throughput 37

Setup view
components 46
functionality 56

sheath
filter 18, 20, 126
fluid

exchanging 106, 107
for use on HTS 70

shipping, packaging 184
soft standby mode 31
software

batch analysis 13, 99
main features 39
menus 41
quitting 110
troubleshooting 158
workspace 40
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specimen
copying and pasting 55
renaming 55

speed, mixing 53
standard mode 34, 51
status indicators, well colors 48, 49
stopping

HTS 93
software 110

syringes, replacing 132

T

technical assistance xi
templates

cleaning 113
experiment 93
plate 85

test, motion 146
throughput

mode 50
optimizing 37

thumbscrew fittings, inspecting 149
time, acquisition 52
total volume 36
troubleshooting

acquisition 155
hardware 154
homing the sample probe 144
leaking valves 131
software 158

tube mode 24, 103
tube-based acquisition

returning to 103, 106
safety 105

tubing
replacing 123, 130
thumbscrew fittings 149

U

unscheduled maintenance 144–151

V

views
Acquisition Dashboard 43
Analysis 62
Browser 42
Inspector 44
plate layout 48
Plate window 44
Setup 46

volume
loader settings 35
minimum sample 52
mixing 53
sample 52
types 36

W

wash station, shown 18, 20
wash volume, probe 53
wells

apply analysis template 54
apply application settings 55
apply cytometer settings 54
border colors and status 48
compensation setup 55
copying and pasting 55
create Experiment Layout 54
cytometer settings in 54
deleting 54
displaying keywords 95
exporting settings and files 54
loader settings in 54
perform panel analysis 54
spectral overlap 54
volume 36
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windows
Acquisition Dashboard 43
Browser 42
Inspector 44
Plate 44

worksheet
global 73
normal 84
setting up 83

workspace 40




